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IN THIS CHAPTER

1

Introducing ArcGIS Survey Analyst 1
Geographic information systems (GIS) technology allows large amounts of
thematic information to be stored for discrete features, such as parcels, road
centerlines, water mains, and electrical utilities. There is often little
information about the quality of the mapped locations of these features.
ESRI® ArcGIS® Survey Analyst, the surveying extension for ArcGIS
software, adds a broad set of measurement-based processing and analysis
tools for improving the spatial accuracy of vector-based features and
determining the spatial quality of GIS feature locations.

Survey Analyst is an application that allows you to store and work with
survey measurements collected from field notes, survey equipment and data
collectors. By using Survey Analyst, surveyors and GIS professionals can
cooperate to add value to the following key GIS operations in your
organization:

• Integrate survey measurements in your geodatabase.

• Improve the accuracy of mapped features.

• Map new features based on surveyed points.

• Organize survey data in projects.

• Maintain data about and report on the spatial accuracy of surveyed
points.

• What is Survey Analyst?

• Adding measurements from the
field

• Defining points with coordinate
geometry

• Organizing survey data in projects

• Linking survey points to feature
coordinates

• Viewing error ellipses

• Exploring survey information

• Tips on learning Survey Analyst

Ch01.pmd 11/24/2003, 4:24 PM1
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What is Survey Analyst?
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Measurements captured in the field or
defined by COGO are added to a survey

dataset in the geodatabase.

Survey datasets define associations
with feature classes. Choose the
feature classes in the geodatabase
that you want to link with your
survey information.

Total
Station

Measurements in a
subdivision plan are added
to the survey dataset and
linked to the feature
coordinates of parcels and lot
lines.
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Adding measurements from the field

You can import and work with the measurements collected in the field using survey equipment.

Total
Station
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Defining points with coordinate geometry
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You can enter coordinate geometry from plans and field sketches to define survey point locations that are used to locate feature geometry.

Subdivision plan
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Organizing survey data in projects
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Whenever you start a new job, you create a survey project in a survey dataset as a place to store your data. This example illustrates a
geodatabase named Arizona that contains a number of vector and raster datasets plus a survey dataset named MaricopaSurvey, which has
a number of project folders.
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Linking survey points to feature coordinates

Survey Analyst links the vector-based features in the geodatabase with the measurements, computations, and survey points
stored in the same geodatabase. Features can be snapped to survey points.
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Viewing error ellipses

Survey Analyst stores information about spatial accuracy for survey points. This information can be be imported, computed, or
propagated through computations and displayed as error ellipses. The size and angle of the ellipse represents the relative magnitude
and direction of the error.
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Exploring survey information
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Delete survey objects after selecting them from a list.

Add new coordinates and
survey points.

Insert new measurements and define new computations.

Correct problems in existing
computations.

Explore and navigate from a set of data to
related information in the survey dataset.
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Tips on learning how to use Survey Analyst
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Finding answers to your questions
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About this book
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Getting help on your computer
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Contacting ESRI
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ESRI education solutions
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Quick-start tutorial 2
• Exercise 1: Organizing the tutorial

data

• Exercise 2: Exploring the survey
dataset

• Exercise 3: Working with survey
data

• Exercise 4: Creating COGO
computations

• Exercise 5: Updating computations
and linked features

• Exercise 6: Exporting survey point
data

ArcGIS Survey Analyst has the tools you need to enter survey data and
coordinate geometry (COGO) into survey datasets. You can import the data
you’ve collected from a total station or enter the tape measurements
recorded on a field sketch or a survey plan. Completing the exercises in this
chapter will provide you with the basic knowledge to use these capabilities.

Tutorial scenario

Your organization is building a geodatabase for Maricopa County, Arizona.
The geodatabase represents parcels and physical infrastructure. Your field
crew has performed a survey to relocate some parcel boundary monuments
and to fix the location of  buildings for an existing subdivision. Coordinated
locations of section corners in the area were used as control for the field
survey. You will use a survey project in your geodatabase to import
measurement data for the boundary monuments that were found, and for
some corners of buildings on the site of the survey. You will use this
information to update the geometry of an existing subdivision block in your
geodatabase and add a new building based on tape measurements recorded
in the field.

You will use a second project to add values recorded on the original
subdivision plan. The survey points computed in this second project will be
exported for use by the field crew to locate any monuments that were not
found in the first field survey. You will use georeferenced images of the
original subdivision survey plans as a background for your work.

Ch02.pmd 11/24/2003, 4:26 PM11
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Introduction to the tutorial

�������
����
�
���
� �����	����
���
'��
������'���%	
���

�(
�	���	�
	��%�������	�

����!�1���
����	����
���
'��
��

�
���
���


��	�

������	�
����
�������
����	�
��������'���	
��������
��!�%�����������
���
���	��
�

�������
���������

�

��
��
���
�
���
���


�����������	�
���	���
�

�
������
��

�	�

��

��	��

�!��������
��
��	�

��

��	��

����

�����3%����
��3���'��4%	
���
 ��	�
������'��������
��

�
���
���


�����	�

����!

5�

�������
����


��
��
�

���������������	�
����
�
���
��
��
�����������	�
����������	��

����!

Geodatabase Description

�
����� ����1�����������������������������
�	
�����	������������>�����������2�
�����
.�	��
7��
�����?

Feature datasets Description

2�
�����.�	��
9�
���� 9�
��������

2�
�����.�	��
8��
� 9�
���������
���
	��	
������

2�
�����.�	��
9"�� 9	1����"�����	
��
��
�����>9"��?
����

Survey dataset Description

�
����� �	
��
�����

Survey folder Description

2�
������.�	��
 C����
�
��
��������������	
��
��������
���� ��	��


Survey  project Description

.�
����<�
 9
� ������
������������������
���
�����31������	
��
�����

.�
�����	1�9��� 9
� ������
������������������
���
����31������	
��
�����

Feature classes Description

9�
���� 9�
�������
����

9�
���"���� 9�
�������
�����

<	������� <	����������
����

*���	��:!'���H���� 9"�����������

*���	��:!'���HF�
 9"���5	�
��
���������

*���	��:!'���H.�
� 9"�����
��
�

*���	��:!'���H"�� 9"���5	�
��
35	�
��
��������������

*���	��:!'���H9��
� 9"���5	�
��
35	�
��
���������

Images (TIFF) Description

<��#�)+9����&�����4, C������	1����������������
�.�
����<�

�����������

<��#�)+9����&�����4� ��������'(�
���

������*�1��� ��������'(�
�����	
�����1���

����
�
���
�����	
����������
�
���� �
	��
������������'����



�
�����	������

��!������
������������


��
	������
���'��
�	��	�������
���*���
�����6
	��.
	
����	
2�������
����
������	

��5


�
������5*��
	�������
����������������
���.
�����
����	
� �
����

����������,



QUICK-START TUTORIAL 13
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Exercise 1: Organizing the tutorial data
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Enabling the Survey Analyst extension
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Defining the display units

5������	
��	�
��
���
'
��
�������������
��	�����	�
���
	�

	����!�1������������	��
���������
����	�
�������
�����	
%���


���!

9! ������������
	��������/�
��	�!

;! ������
������'���.�
������	
�>���

��

�!

=! ������
���5���	���>���

���������	�
�����
	�������
%	���!

?! ������
���5�����).�	�
�)����	����
��	�
�������
��
!

@! ��
	���
�����������	�
��A!�1��������������	��������	�
�
�������	��!

B! ��������
�%��5����
��>���

!

�

C! ������
���5���	���>���

���������	�
�����
	�������
6�	�
�!

D! ������
�������	��A!AAA�
��	�
������
�����8��>��
 �
	�������
��
�%��5����
��>���

!

E! ������/�!

1���
���	�����
���
���

�
��(�����	��
������'����


��
�
	�
�����	����
����������'����	����

��	!�%������
������'��
�	����

��	��������������
�������	��
����	�
�����2'�
���������!

�

�

�

�

�



16 USING ARCGIS SURVEY ANALYST

=! ������
���:
��
����

�!

�����
��
����
���
������'����


�
�����
�

��
	���
�
������	�
������'����


��
!��	�
����
�
���
� ������������
�����
�	��
	�������	����
�����������'����


������
�

�
����
��	�	���


��	���:����"�����	
 �
	�����������
������
���	��
	���
���	���/�/!

/	����
��
����
���
���� ������
		�
�����'��
���
�����
������'����


��
!

���'����	����

��	�����
������	�
�������


�
����	����'��
�


��
�!�%����'����


��
����
���������	��'��������
��	���
���'������	
� ���
������	
� �
	�������


��	�!�1�������	�

���	�������'����


��
�
�����'������������	���
�������
�
��������
�������������

�����


��
��
	����

������
����!
�������'����


��
���'����
����(
�	
�����������
	
����	


��
!

Viewing the survey dataset properties
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Viewing the survey project properties
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Previewing the data for survey projects
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Importing from a data collector file
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Using the Import Survey Data Wizard
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Exercise 3: Working with survey data
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Enabling the Survey Analyst extension

*��������	
�	��	� ��������
��	
�������'���%	
���
��������
�	�%��.
�!

9! ������������
	��������#(
�	���	�!

;! ������
������'���%	
���
���������(!

=! ������
�����������

�	!

Setting the survey layer properties

%����'����
�������'��������(�����
���	������
��	�����'��
�	����

��	��	�
��
��
�

������
	�	��������������

��!�1��2��
��
	���
���������
��������
���	������'����
����
�����

�������	
�
����
���������:�
	����0��
!

9! $���
)������
���%��+�	
����'����
����
	�������
:�����
���!

;! �����I�
�����*
������:�
	J�
��
���6
����<
����	�
��
��	��
��

�!

%����'����
�����
��
�����
���������
������
����


�
����
������
������
������'����


��
!�1����
	���	
����
��
	�������������
����������
�����	�
������'����
���!�����
�

�
�


��	���
������	
��
���	�
�	����������
����
�����*
�
����:�
	����'������0��
 ����
�������
����
�

��������	
�

��������	�
���"�����!���������� �����	����
������'��
��
����
�����������	
�	��
�

���


��	���
������	
�!

�

�

�

�



QUICK-START TUTORIAL 27

=! ������
������)6
�����

��
	���������:��.�
������	
�!

?! ������
���$���'����

�	!

�������'����
�����
	���������
�������
���


������
���
��
���0��
�����
������'����


��
 �����
��
	���������
�������
�
�


������
������������
�������'������0��
�!�1��2����	����

�

����	��
����	������0��
��
���
�����
��
������'��
�


��
 �
�������'����
����������	��������
��
����
��������
:�
	����0��
!

@! ������
������'���:��0��
��

�!

B! ������
�����������	�	�(
�
��
���.
�����
����	
�����'��
������!

C! 8	������
����
�����*
�����0��
�
	��'������
�

�
��
�
���������:�
	����0��
�����������!

D! ������/���	�
���6
����:�����
������
������(!

Saving your map document

<�������������
'��
�����
	���������
'���
���
��
����
�
������	
����
�

��������	�
�	����
������

�
�������
��	���
�����������
���
���
����
�
���
��
	����	
�	���

�
��

���
���!

9! ������
����
'����

�	!

�

�

�

�

�

Map displaying the survey information in the Arizona survey dataset.
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Working with the Survey Explorer
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Listing points in the Survey Explorer
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Navigating to the details of a stored computation
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Finding stored computations with the Survey Explorer
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The General tab provides information to identify
the computation and its limits.
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Editing survey data

Computing coordinates and analyzing coordinate quality is
the most important feature of Survey Analyst.

In this exercise, you will define computations to calculate
coordinates for points, link a parcel block feature to points,
and update the feature’s location. To do this, you will add
your imported measurements to a new computation.

Starting an edit session and setting the editing
environment

Before you start defining computations, you need to start
editng and set your editing environment. You will add a new
type of task to the standard set available in the Editor
toolbar and also set the Target project for your edits.

Adding an edit task

1. Click the Editor menu and click Start Editing.

If the Starting To Edit In A Different Coordinate System
dialog box appears, click Start Editing.

2. Click Editor on the Editor toolbar and click Options.

3. Click the Edit Tasks tab and click Add.

4. Click <none> in the Add Tasks dialog box and click OK.

5. Click OK in the Editing Options dialog box.
�
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�
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Creating a new field traverse computation
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Setting the target project
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Zooming to the Carmel Bay project area
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Defining the second traverse and side-shots
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Defining orientation and computing
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Viewing the traverse misclosure information
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Editing features using survey points
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Using the Link tool
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Using the Link command
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Using the Update Feature Vertices command
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Turning off the survey layer
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Saving your edits and your map document
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Exercise 4: Creating COGO computations

Setting up a point naming increment
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Adding a building using COGO computations
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Using the distance-distance intersection computation
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Adding the final building corner
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Using the deflection angle distance computation
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Using the final closing distance as a check
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Creating the building feature
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Comparing coordinates of a survey point
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Navigating to survey point details
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Comparing and averaging coordinates of a survey point
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Entering COGO from plan data
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Changing the automated point management settings
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Creating a station and offset computation

9! ������
����
����������	�
������	�
���#��
���
����
��
	�
������N	�	�O!

;! ������
���:��0��
��������	�
�����
	�������
%��+�	
�)��
���������:�
	!

=! ������
���#��
���
	���������	
���	�!

�����	
���	��#	'���	��	
���
������(�
���
��!

?! 8	������K��
�(� ����:
�����!

@! ������
���
�����
��

���������	�
���� ����	
�
��
��
�/�/�%�'
	���������


��	����

�	�
	��������
��
�


��	�
	��/����
���

�	!

�������'���#(������������
���
���	����


��	������

�����


��	!�1������������
���������


��	�
������	��

���	
��	���	����
���	����	
���AAB�
	���AA@!

B! �������AAB��	�
����
� �
��	��������AA@!

�

�

�

�



QUICK-START TUTORIAL 51

C! ������
����������	�
����������


��	�	��
��� ������
K
��
�������

	��� �
	��������#	
��!

D! :�����#	
���
	��
����IEA!CEJ�����
������

	���'
���!

E! :�����#	
���
�����
����'��
��
���:��	
������!

9A! �����I9A9J�����
������	
�������
	��������#	
��!

99! :�����#	
���
���� �
	���	�
���K
����������
����IE9!?EJ!

9;! ������:�����
��	!

%����'������	
���������
����	��	����
���	��AAB�
	�
�AA@!������������	�����
���	�
��������
��������	�
���

	���
	���	
��������

	������������
��	��!

�




�

�

�

Saving your edits

1����
'���������������
�����
���
	)�
�����/�/
�����


��	�
��
�������


�
��!

9! ������
���#��
�����	��
	���������
'��#��
�!



52 USING ARCGIS SURVEY ANALYST

Exercise 5: Updating computations and linked features
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Updating the linked features
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Exercise 6: Exporting survey point data
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Survey Analyst concepts

• Survey data in the geodatabase

• The survey project

• Modeling survey points and
coordinates

• The survey dataset

• Survey-aware feature classes

• Modeling computations

• Modeling measurements

• Modeling survey object
dependencies

• Least squares
adjustment—overview

• Survey points, measurements, and
the spatial reference

Surveying is the science of collecting measurements to determine the
relative spatial locations of points on or near the surface of the earth.
Relative spatial locations are represented by coordinates. Coordinates stored
in a GIS are used to represent physical objects that depict natural and man-
made features on a map.

To establish coordinates for points, surveyors use precise field instruments,
procedures, and computations. They measure slope, horizontal and vertical
distances between points, and angles between lines of sight.

Measurements, computations, survey points, and coordinates, collectively
called survey objects, are stored in a survey dataset in the geodatabase.

In addition to storing these objects, Survey Analyst can track dependencies
between computations. Computations define points that can be used as input
for other computations. These dependencies are modeled in Survey Analyst
as a computation network.

Physical objects are represented in a geodatabase as features stored in
feature classes. Survey Analyst enhances feature classes with survey-
awareness, allowing stored features to be associated with survey data.

This chapter explains the survey data model, describes the computation
network, and presents the concept for associating GIS features with survey
data.
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Survey data in the geodatabase

The survey data model includes four data types
that are used to analyze and solve problems
related to the processing of survey data stored in
the geodatabase.
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Survey measurements are used to compute survey points. Survey
points are used to update the geometry of survey-aware features.
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Performing a survey
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The third phase of a survey project requires calculating coordinates by
processing measurements collected in the field.
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The survey project

Through time, surveyors collect discrete sets of survey data
that can be accumulated into a single dataset.

The information collected for each survey is grouped into separate
units of work called projects.
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Records added as a result of new survey activity are referenced in the
geodatabase as a survey project.
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The GIS coordinate
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Modeling survey points and coordinates

There is a one-to-many relationship between survey points
and coordinates.
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The current coordinate
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Working with multiple projects
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The Magenta project does not own new measurements and survey
points. It uses the existing survey points and measurements stored in the
survey dataset.
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The Magenta project copies coordinates from survey points and
computes a new coordinate for P2 of the Blue project.
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The survey dataset

A basic depiction of the core tables of a survey dataset
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Survey-aware feature classes

Survey points can be linked to survey-aware features.

Links

Vertex IDs of the
feature

Survey
point

Links are maintained in the geometry attributes of features. Each linked
vertex stores a VertexID number that matches the unique identifier of its
linked survey point. Vertex IDs are positive integers; 0 means no link.

Geometry
attributes

Links

No links

Using links, features can be snapped to survey points.
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Computation states
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Computation dependencies
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Modeling computations

AlgorithmAlgorithm

in-parametersin-parameters

out-parametersout-parameters

Points
Measurements

Points
Measurements

TraverseTraverse

PointsPoints

Computations store references to survey
points and measurements. These are
used as input parameters to calculate
new coordinates for survey points.

Computation Example

Computation 1

1

2

3

1

2

3

4

Computation 2

4
A

B

C

Depends on

Computation 2 is dependent on point 4. Since point 4
is defined by Computation 1, Computation 2
depends on Computation 1.
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Computation networks
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The computation network maps dependencies between computations in
a survey project.
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Parameters

Parameters
Parameters

Parameters

C1
C2

C3

Computation Network

Input

Output
Network dependency

Points

Points
Points

Points

C1
C2

C3

Computation Network

Input

Output
Network dependency

Multiple computation types
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Computations

   1   Computation1   Traverse

   2   Computation1   AngleDistance

   2   Computation2   AngleDistance

3   Computation1   Traverse

  4   Computation1   Least Squares

TypeNameProject
ID

Field survey
computations

COGO computations

COGO Delta XY

COGO Fillet Curve

COGO Traverse

COGO Angle Distance

COGO Distance Distance

COGO Station offset

COGO Direction Distance

COGO Circular curve

COGO Direction direction
Intersection

COGO Direction Distance
Intersection

TPS Free Station

TPS Traverse

TPS Least Squares

TPS Resection

TPS Tacheometry
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Modeling measurements
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Modeling COGO measurements
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Modeling field measurements
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COGO Composite measurement

COGO Simple measurement

A COGO composite measurement depends on
COGO simple measurements for its definition.

Field measurements from a theodolite are modeled as a field
book with pages of recorded observations. Each line entry is a
TPS measurement, and each set of entries represents a single
instance of an instrument setup.

TPS
Measurement

The example shows how a composite measurement requires a
simple measurement to represent a deflection angle.
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TPS Setup

TPS Simple measurement

A TPS setup is comprised of a set of TPS measurements.
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Modeling survey object dependencies
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Relationship tables for survey
object classes
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The techniques and algorithms supported by the least squares
computation provides the most rigorous method available for
processing the observations in a survey network.

If you are familiar with these techniques, this section provides a
review of the basics. If you are new to these concepts, treat this
section as an introduction—it is recommended that you refer to
the literature listed in the References section of this book.

What are measurements?

A measurement is an observed numerical value that is an estimate
of the true size of a quantity.

Measurements are best described by comparing measuring with
counting. Put simply, counting determines exact numbers and
measuring does not. For example, if several people are each asked
to count the number of fish in a tank, their counted values are
either right or wrong. There is no uncertainty in the result
because the exact number of fish in the tank is a realistic, known
target.

By contrast, consider the following scenario: several people are
each, in turn, given a tape measure and asked to calculate the
volume of water in the fish tank by measuring the length and
breadth of the tank, and the depth of the water. They are asked to
do this as accurately as possible and to estimate fractions of the
measurement unit of the tape measure.

Each person will derive a different volume. Which of these is
correct? Unlike the exact quantity of fish, there is no exact
quantity for the volume of water with which to compare results.

Most calculated volumes for the tank are likely to be close to the
true value, while some others may be incorrect due to mistakes in
one or more of the tank’s measurements. Uncertainty in
measurements is an accepted truth. It exists because:

• The observer makes estimates.

• There is imperfection in the measuring equipment.

• The environment in which equipment and observer operate
affects the measurement.

• The behavior of equipment, observer, and the environment
cannot always be predicted.

These last four points can be categorized into two groups:
measurement error, and mistakes. If you measure with care,
mistakes can be avoided. However, the same measurements will
always contain error. As illustrated in the fish tank example, a
measurement with a mistake is not useful for calculating the
volume of water. It should be removed, and the quantity
remeasured. However, a measurement with error is expected. You
expect the different measurers to obtain different values for the
volume of water.

Surveyors recognize and work within this environment of
mistakes and errors. To get close to the true value of the
measured quantity, it is important to identify and remove
mistakes, and to apply mathematical and statistical methods to
deal with measurement error.

Measurement error

Measurement error is classified as either systematic or random.

Systematic error follows a mathematical or physical law and can
be corrected to comply with a known standard. Corrections are
always applied the same way—for example, if a tape measures a
standard 100-foot baseline as 99.89 feet, then every measurement
of this magnitude has a systematic error of 0.11 feet. A correction
of 0.11 feet is always added to the measured value. Surveyors
calibrate measurement equipment to reduce systematic error.

Least squares adjustment—overview
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Coordinate quality—precision versus accuracy
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This grouping of dart throws is both
precise and accurate.

This grouping is precise but
inaccurate.

This group of dart throws is imprecise
but it is accurate. Its center of gravity
falls close to the bulls-eye.
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Redundancy in measurements
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Least squares adjustment
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Mathematical model
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This triangle has redundant
information. All of the measured
angles and distances are useful for
describing the triangle’s geometry,
but they do not define a unique
solution. Where redundancy like this
exists, a least squares adjustment
solves for a best-fit solution.
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Stochastic model
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This graphic shows the normal probability distribution curve. The normal
distribution is based on the mean and standard deviation of a measured
quantity.
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The least squares adjustment formulae
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The variance–covariance matrix is modeled as six attributes in the
survey points and coordinates tables.

Survey Points
 GIS
Coordinate ID

Point
Name

Project
ID

 Variance-Covariance matrix
Qxx  Qxy  Qxz  Qyy  Qyz  Qzz

Current

Coordinates

Type Coordinate
Project
ID OID

Survey
Point ID

 Variance-Covariance matrix
Qxx  Qxy  Qxz  Qyy  Qyz  Qzz
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Survey points, measurements, and the spatial reference

The extent of the spatial domain affects the precision with
which geometry can be stored.

1 map unit

1 map unit

Exaggerated grids
and map unit



SURVEY ANALYST CONCEPTS 79

Maintaining numerical precision
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Survey points have
a point geometry
field to represent a
mapped location for
the GIS coordinate.

Survey Points

  1           B1         XYZ         101    Point Geometry

  1           B2         XYZ         102    Point Geometry

  1           P1         XYZ         103    Point Geometry

  1           P2         XYZ         104    Point Geometry

  1           P3         XYZ         105    Point Geometry

  2           R1         XYZ         106    Point Geometry

  2           R2         XYZ         107    Point Geometry

  3           P1         XYZ         108    Point Geometry

  3           P2         XYZ         109    Point Geometry

GIS
Coordinate ID

Point
Name

Project
ID

Shape

Survey point geometry is stored using the
spatial reference of the survey dataset.
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Organizing survey data 4
• Managing and exploring survey

data in ArcCatalog

• Creating survey datasets

• Using scalar references and
defining measurement units

• Creating and managing survey
projects

• Importing survey measurements
and points

• Previewing survey data

• Exploring and viewing survey
properties and metadata

As you work with survey information in Survey Analyst, you will want to
import, organize, and explore the data.

ArcCatalog allows you to browse through the information stored in your
survey dataset. This data can be managed in projects and folders. In this
chapter, you will learn how to organize your survey data by:

• Creating a new project in a survey dataset

• Working with scalar references and defining custom measurement units

• Viewing and changing project and dataset properties

• Importing survey data

• Previewing measurements and points stored in your projects

• Reading and writing metadata about a project or dataset

Ch04.pmd 11/24/2003, 4:30 PM81
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Managing and exploring survey data in ArcCatalog
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Survey datasets store survey information as records for
measurements, computations, and points.

Project folders let you group projects that share a
common category of survey.

Information in the survey dataset is entered through
survey projects.
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Understanding survey datasets
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Spatial reference
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Packages
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Survey-aware feature classes
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Creating survey
datasets
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Creating a new survey
dataset

1. Right-click on the
geodatabase in the
ArcCatalog tree in which you
want to create a new survey
dataset.

2. Point to New.

3. Click Survey Dataset.

4. Type a name for the survey
dataset.

5. Click Next. �

Tip

Naming the dataset
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6. Check the measurement data
types that you will use in the
new survey dataset. These
define the data type
packages.

7. Click Next.

8. Click Select or Import to
choose a spatial reference
for the survey dataset.

9. Navigate to the spatial
reference that you want to
select, or navigate to the
feature class or feature
dataset from which you want
to import the spatial
reference. Click Add.

10. Type the latitude and
longitude extents to define
the x, y domain of the survey
dataset.��
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11. Check the feature classes
that you want to make
survey-aware.

12. Click Finish.
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Using scalar
references and
defining
measurement
units
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Adding the scalar
references to the Catalog
entries

1. Click the Tools menu and
click Options.

2. Click the General tab.

3. Check Scalar References.

4. Click OK.

The scalar references node
appears in the Catalog.
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Creating a new scalar
reference to define south
azimuth

1. Right-click Scalar
References in ArcCatalog,
point to New, and click Scalar
Reference.

2. Type a unit name for the new
scalar reference.

3. Click the Base unit Type
dropdown arrow and click
Angle.

4. Type the number of radians
for each base unit. In this
example, there are
57.29577951308232
degrees in one radian.

5. Type a value for the zero
offset. In this example, south
azimuth is 180 degrees offset
from north at zero degrees.

6. Click OK.
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Creating a new scalar
reference to define
Fahrenheit

1. Right-click Scalar
References, point to New,
and click Scalar Reference.

2. Type a unit name for the new
scalar reference.

3. Click the Type dropdown
arrow and click Temperature.

4. Type the number of degrees
celsius for each base unit. In
this example, there are 1.8
Fahrenheit degrees in 1
Celsius degree.

5. Type a value for the zero
offset. In this example, zero
degrees Celsius is 32
degrees Fahrenheit.

6. Click OK.
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Changing display units

1. Click the Tools menu and
click Options.

2. Click the Survey
Measurement Formats tab.

3. Click the Defined Formats
dropdown arrow; click the
type of unit for which you
want to set the display
settings.

4. Click the display unit that you
want to use.

5. Type the number of decimal
places to be used for
displaying the units.

6. Click Set As Display Format.

7. Click OK.

Displaying different
measurement units
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Creating a custom
display for south azimuth
directions using degrees
and minutes

1. Click the Tools menu and
click Options.

2. Click the Survey
Measurement Formats tab.

3. Click the Defined Formats
dropdown arrow and click the
type of unit for which you
want to customize the display
settings.

4. Click the display unit on
which you want to base the
new format. �

Customizing unit display
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5. Check Advanced.

6. Click the New button.

7. Click the Based on Scalar
Reference dropdown arrow,
and click the scalar reference
on which you want to base
the display format. In this
example, it is a scalar
reference defined for south
azimuth.

8. Type a name for the display
format.

9. Double-click the Abbreviation
field and type new
abbreviations for the
subfields. In this example, d
is used as an abbreviation for
degrees, and m is used for
minutes.

10. Delete unwanted subfields
by clicking the leftmost
column of the subfields
section and pressing Delete.

In this example, units of
seconds are not required
and are removed.

11. Click Set As Display Format.

12. Click OK.
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Saving custom units of
measurement

1. Follow the steps in the
previous task to create a
custom display unit.

2. Click Save.

3. Navigate to the location in
which you want to save the
unit of measurement file.

4. Type a name for the file.

5. Click Save.

6. Click OK on the Options
dialog box.
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Understanding survey projects
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Coordinate system
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Project locking
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Creating and
managing survey
projects
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Creating a new survey
project

1. Right-click the survey dataset
or the project folder in the
ArcCatalog tree in which you
want to create a new project.

2. Point to New and click
Survey Project.

3. Type a name for the project.

4. Click Next. �

Creating a new survey
project folder

1. Right-click the survey dataset
or the folder in the
ArcCatalog tree in which you
want to create a new folder.

2. Point to New and click
Survey Project Folder.

3. Type a name for the folder.

4. Press Enter.

Tip

Naming the Project
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5. Skip to step 8 if you want to
accept the default coordinate
system, which is the same as
the coordinate system for the
spatial reference of the
survey dataset.

6. Click Select or Import to
choose a coordinate system
for the survey project.

7. Navigate to the spatial
reference that you want to
select, or navigate to the
feature class or feature
dataset from which you want
to import the spatial
reference. Click Add.

8. Click Next.

9. Type the point name prefix
that you want to use for this
project.

10. Click Next.��

See Also
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11. Type a scale correction and
angle correction if you want
to use values other than the
default values. These
defaults apply no correction
to the coordinates calculated
using COGO computations.

12. Type default standard
deviation values for the
measured angles and
distances, and for centering
the target and instrument.

13. Click Next.��
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14. Click the Sea Level Correc-
tion Method arrow and click
the method that should be
applied for computations in
this project.

15. Repeat step 16 for the
Projection Correction and
Meteo Correction methods.

16. Click Finish.
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Importing survey
measurements
and points
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Operation codes and
feature codes
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1. Right-click the survey project
into which you want to import
the survey data.

2. Click Import Survey Data.

3. Click the Survey Data
Converter dropdown arrow to
choose the format of the file
that you want to import.

4. Click the Browse button and
navigate to and select the
data collector file or ASCII
file. You can also directly type
its path and name.

5. Click Properties. �
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6. Skip to step 12 if you are
importing an ASCII file
format.

7. Click the Operation Code
Handler dropdown arrow and
choose the code handler you
want to use for your selected
file format.

8. Click Settings.

9. Change the Operation Code
Settings specific to the code
handler you selected. Click
OK on the Operation Code
Settings dialog box.

10. Click OK on the Survey
Format Properties dialog
box.

11. Skip to step 30 if you are not
importing an ASCII
coordinate file.��
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Defining an import
template for ASCII files
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Importing coordinates
from a local coordinate
system
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12. Click the Format Template
dropdown arrow to select it if
you want to use an existing
import template, then skip to
step 29.

Otherwise, follow steps 13–
28 to create a new ASCII
import template.

13. Click New to create a new
template.

14. Type a name and description
for the template.

15. Click Next. �
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16. Click Free for files that have
a special character between
coordinate fields and point
name fields; otherwise, click
Position to use interactive
field-column definition.

17. Type the number of lines to
ignore at the top and the
bottom of the text file, and
type a keyword if required.

18. Click Next.

19. Check all the types of
delimiters that should be
used to identify columns.

20. Click Next.��
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Ignoring lines
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Using the keyword
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Column separators
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Consecutive delimiters
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21. Skip to step 26 if you clicked
Position on the previous
page of the wizard.

22. Click the header row in the
horizontal position where
two field columns should be
separated.

23. Repeat step 22 for all the
fields.

24. Right-click a column header
and click the field type that it
represents.

25. Repeat step 24 for each of
the fields that should be
identified for import.

26. Click the Linear Units drop-
down arrow and click the
unit type for the coordinates
in the ASCII file.

27. Click Finish.

The template is created. �
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Inserting column
separators
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Removing a column
identifier
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Deleting a column
separator
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What is the point prefix
separator?
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28. Click the Template name
dropdown arrow and click
the new template you
created.

29. Click OK.

30. Click Next.

31. Click the second option if
you want to specify that the
source file has a projected
coordinate system that is
different from the target
project, or that it has a local
coordinate system.

Otherwise, skip to step 35.

32. Click Transformation.

33. Click the Method dropdown
arrow and click the method
you want to use.

34. Type the transformation
parameters, if required, and
click OK.

35. Click Next.��
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Defining default standard
deviations
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Creating a log file
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36. Type the point prefix
separator string.

37. Type default standard
deviations for position and
elevation.

38. Click Next.

39. Click the Browse button and
navigate to the location in
which you want to save the
log file. Provide a log file
name and click OK. You can
also directly type its path
and name.

40. Click Finish and click OK on
the Import Survey Data
Wizard dialog box.
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Previewing
survey data
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Previewing survey points
and measurements

1. Click the survey dataset
folder or project you want to
preview.

2. Click the Preview tab.

Identifying survey points
and measurements

1. Click the Identify button on
the Geography toolbar.

2. Click the survey point or
measurement in the preview
that you want to identify.

3. View the details displayed in
the Identify Results dialog
box.

See Also
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Exploring and
viewing survey
properties and
metadata
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Exploring survey dataset
and project properties

1. Right-click the survey dataset
or survey project for which
you want to see properties.

2. Click Properties.

3. Explore the properties using
the tabs in the Survey
Dataset Properties dialog
box. You can change the
properties for your survey
dataset or project.

4. Click OK.

See Also
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Viewing project metadata

1. Click the project or survey
dataset.

2. Click the Metadata tab.

3. Click a tab on the metadata
page to see a specific
category of the metadata
contents.

4. Click the Stylesheet
dropdown arrow to change
the metadata’s appearance.
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Visualizing survey data 5
In ArcMap it is possible to draw, query, and edit the survey data stored in
a survey dataset. Using survey layers to draw measurements and survey
points, you can visualize survey datasets and survey projects on the
map.

There are many ways to represent your survey data on the map. For
instance, you can:

• Label points and measurements based on attributes, such as point
name or measurement value.

• Display points and measurements in multiple sublayers using different
symbols to represent different characteristics.

• Create a legend to describe the purposes of symbols.

• Display magnified error ellipses for survey points.

• Limit the display to survey objects owned or referenced by a specific
set of projects.

In this chapter, you’ll learn about the different properties of survey layers
and how to map your survey data in the most effective way for your
specific task.

• Exploring survey layers

• Creating survey layers

• Working with symbols and labels

• Visualizing error information

• Using survey fields for symbology

• Representing projects in a survey
layer

• Symbolizing feature links

Ch05.pmd 11/24/2003, 4:31 PM109
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Exploring survey layers
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Survey layers display the points and measurements stored in the survey dataset.

Sublayers are used to draw points or measurements based on their properties.

Different symbols on the map distinguish different types of measurements.

Labels are used to provide descriptive text for the
survey objects on the map.

Click here to add a survey layer to the map.

Use the Layer Properties dialog box to add and
remove sublayers and change their drawing order.

Error ellipse symbols can be defined for survey point sublayers.
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Drag and drop projects, folders, or survey datasets
from ArcCatalog to ArcMap.

Use the survey Layer Properties dialog
box to define the survey projects that the
survey layer represents.
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Creating survey
layers
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Adding a survey dataset
in ArcMap

1. Click the Add Data button on
the Standard toolbar in
ArcMap.

2. Click the Look in dropdown
arrow and navigate to the
geodatabase that contains
the survey dataset that you
want to add to the map.

3. Click the survey dataset.

4. Click Add.

ArcMap creates a new layer
on the map that represents
all the projects in the survey
dataset.

Adding a survey project
from ArcCatalog

1. Arrange the ArcCatalog and
ArcMap windows so that you
can see both on the screen.

2. Navigate to the survey
project in ArcCatalog that you
want to add to the map.

3. Click and drag the project
from ArcCatalog.

4. Drop the project over the
map display in ArcMap.

ArcMap creates a new layer
on the map that represents
the project.

Tip

Adding a project folder
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Adding a new sublayer to
a survey layer

1. Right-click the survey layer to
which you want to add a
sublayer.

2. Click Properties.

3. Click the Sub-Layers tab in
the Layer Properties dialog
box.

4. Click Add.

5. Click the name of the survey
class for the sublayer type
you want to add.

6. Click Add in the Add Sublayer
dialog box.

7. Click OK in the Layer
Properties dialog box.

Tip

Removing a sublayer
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Drawing order of sublayers
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Sublayer properties
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Layer properties
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Creating a point sublayer
symbol

1. Right-click the survey point
sublayer.

2. Click Properties.

3. Click the Symbology tab.

4. Type the text you want
displayed next to the symbol
in the legend.

5. Click the Symbol button. �

Working with
symbols and
labels
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6. Click the Category dropdown
arrow and select a point
symbol category.

7. Scroll through the available
symbols and click the symbol
you want to use.

8. Click Color to choose a color
for the new symbol.

9. Type a symbol size.

10. Type a symbol rotation value
if you want the symbol to be
rotated.

11. Click OK on the Symbol
Selector dialog box.

12. Click OK on the Layer
Properties dialog box.
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Symbol Property Editor
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Changing the way TPS
measurements are
symbolized

1. Right-click the TPS Measure-
ments sublayer containing
the symbol you want to
change.

2. Click Properties.

3. Click the Symbology tab.

4. Click the Measurement tab.

5. Click the Symbol button to
change the instrument
measurement observations
symbol.

6. Click the Category dropdown
arrow and choose a line
symbol category.

7. Scroll through the available
symbols and click the line
symbol you want to use.

8. Click Color to choose a color
for the new symbol.

9. Click Properties. �
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10. Click the Properties Type
dropdown arrow and click
the type you want to use.

In this example, a
cartographic line symbol is
chosen so that an
arrowhead can be used at
the endpoint of each
measurement.

11. Click the Line Properties tab.

12. Click the line decoration
style you want to use and
click Properties.

13. Click the Category
dropdown arrow and select
a point symbol category.

14. Scroll through the available
symbols and click the
symbol you want to use.

15. Click Color to choose a color
for the new symbol.

16. Type a symbol size.

17. Type a symbol rotation value
if you want the symbol to be
rotated.

18. Click OK on the Symbol
Selector dialog box.

19. Click OK on the Symbol
Property Editor. �
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Labeling all survey points
in a sublayer

1. Right-click the sublayer you
want to label and click
Properties.

2. Click the Symbology tab.

3. Click the Point tab.

4. Check Show Text.

5. Click Settings. �

20. Click the Setup tab.

21. Click the Symbol Selector
button to change the symbol
for instrument setup.

22. Repeat steps 13–18.

23. Click OK on the Layer
Properties dialog box.
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6. Click the Label Field
dropdown arrow and click
the field you want to use as a
label.

7. Click Expression.

8. Double-click, in order, any
additional fields you want to
add to the end of the label.

9. Click OK in the Expression
Properties dialog box.

10. Click OK in the Text Settings
dialog box.

11. Click OK in the Layer
Properties dialog box.
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Labeling a subset of
survey objects in a
sublayer

1. Right-click the sublayer in the
table of contents you want to
label and click Properties.

2. Click the Symbology tab.

3. Click the tab for the measure-
ment or point you want to
label.

In this example, it is the
Measurement tab for total
station observations.

4. Check Show Text and click
Settings.

5. Click the Method dropdown
arrow and click Label using
advanced options.

6. Click the Label Field
dropdown arrow and click the
field you want to use as a
label.

7. Click SQL Query. �
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8. Click the operators and
double-click the fields in the
Fields list to build an expres-
sion to identify the subset of
survey objects that you want
to label.

In this example, total station
measurements with a slope
distance between 200 and
300 will be labeled with their
horizontal angles.

9. Click OK.

10. Click Label Styles to choose
the style—for instance, font
and size—of the label you
want.

11. If you want to create addi-
tional subsets of survey
objects to label, click Add
and type a new class name.

12. Repeat steps 7–10 to create
additional subsets of survey
objects that you want to
label.

13. Click OK.
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Drawing error ellipses for
survey points

1. Double-click the survey point
sublayer name for which you
want to display error ellipses.

2. Click the Symbology tab.

3. Check the Show Error Ellipse
check box.

4. Click the Symbol Selector
button if you want to change
the symbol for the error
ellipse.

5. Type a value for magnifica-
tion of the error ellipse for
displaying it on the map.

6. Type a text description to be
used in the legend for the
survey point sublayer.

7. Click OK.

Visualizing error
information
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Defining which survey
objects to display based
on their attribute fields

1. Right-click the survey point
sublayer.

2. Click Properties.

3. Click the Symbology tab.

4. Click Query Builder.

5. Double-click the field you
want to use in the query.

6. Click the logical operator you
want to use.

7. Scroll through the unique
values list and click the value
you want to use as part of the
query, or type the value in the
query box.

8. Click Verify to verify the
query.

9. Click OK.

Using survey
class fields for
symbology
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Using the NOT operator
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Changing the projects
represented in a survey
layer

1. Right-click the
SurveyFramework layer.

2. Click Properties.

3. Click the Survey Projects tab.

4. Expand the survey folders
and check the projects that
you want to be visible
through the survey layer.

5. Click OK.

Representing
projects in a
survey layer
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Switching on symbols for
feature links

1. Click View in the Main menu
and click Data Frame
Properties.

2. Click the Feature Link tab.

3. Check Show Vertex States to
display a link symbol on
feature vertices that are
linked and a snap symbol on
feature vertices that are
snapped.

4. Check Show Link Lines to
display link-lines between
survey points and feature
vertices.

5. Click OK.

Symbolizing
feature links
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Changing the symbols
for feature links

1. Click the View menu and
click Data Frame Properties.

2. Click the Feature Link tab.

3. Click the Snapped State
Symbol Selector button.

4. Click the Category dropdown
arrow and select a symbol
category.

5. Scroll through the available
symbols and click the symbol
you want to use.

6. Click Color to choose a color
for the new symbol.

7. Type a symbol size.

8. Type a symbol rotation value
if you want the symbol to be
rotated.

9. Click OK on the Symbol
Selector dialog box.

10. Click the Link Line Symbol
Selector button if you want to
change the Feature Link
Line symbol and repeat
steps 4–9.

11. Click OK on the Data Frame
Properties dialog box.
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Changing the scale range
for feature link symbols

1. Click the View menu, and
click Data Frame Properties.

2. Click the Feature Link tab.

3. Click the Scale Range
button.

4. Click Don’t show when
zoomed.

5. Type the minimum scale in
the Out beyond 1 text box.

6. Click OK on the Scale Range
dialog box.

7. Click OK on the Data Frame
Properties dialog box.

In this example, the link lines
and feature vertex symbols
will not be displayed at a
scale lower than 1:10000.

Scale range for feature
link symbols
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129

You can explore and edit your survey data in the Survey Explorer. It is
important to be able to visualize survey points and measurements as
described in the previous chapter. You also need to view and analyze
numerical values of measurements and coordinates created in your survey
dataset. To obtain this information, tools and commands are used to add lists
of coordinates, measurements, and computations to the Survey Explorer.

In this chapter, you will interact with the Survey Explorer by:

• Selecting rows of survey objects from a list

• Applying operations to selected rows of survey objects

• Navigating from selected survey objects to dependent objects in a
computation network

• Moving back and forth between pages stored in a stack

• Viewing the details of a stored survey object

This chapter covers the important tools and commands for exploring and
navigating the survey dataset, as well as the details of working with the
Survey Explorer.

Using the Survey Explorer 6
• An overview of exploring survey

data

• The Survey Editor toolbar

• Working with the Survey Explorer

• Creating list pages

• Selecting survey objects

• Navigating dependencies

• Navigating to details

• Map highlighting options

• Using the Active object context
menu

Ch06.pmd 11/24/2003, 4:33 PM129
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Exploring survey data: an overview
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New Map File button
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collection of pages
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to details

Navigate to
dependent
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Create a
list page

Add Data button

Add the Survey
Editor toolbar to
the map
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The Survey Editor toolbar

Survey Explorer
button: opens the
Survey Explorer.

List Survey Objects
tool: allows you to
add lists of points

and measurements
to the Survey

Explorer by
dragging a box.

List Survey Objects
By Query
command: allows
you to add lists of
survey objects to
the Survey
Explorer by
defining a query.

Using the List Survey Objects by Query
dialog box

Using the List Survey Objects tool
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Working with the Survey Explorer
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Survey points can be displayed as attributed list pages.

Backward and Forward buttons let you move between Survey Explorer pages.

A navigation menu lets you explore related survey objects in the survey
dataset.

Selected survey objects are used to start navigation and to do other activities.

Computation details are displayed in detail pages.

The active and dependent computations can be processed from the Survey
Explorer toolbar.
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What are selected, active, and highlighted survey
objects?
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Active survey
object

Selected
survey objects

Active survey
object in a
detail page

Highlighted list
selection

Choose a
highlight color

Highlight
selected
objects

Highlight
active
objects
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Creating list
pages
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Opening the Survey
Explorer automatically
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Using the List Survey
Objects tool

1. Click the Zoom In tool.

2. Click and drag a box to zoom
to the area of interest on your
map for the measurements
and points you want to
explore.

3. Click the List Survey Objects
tool.

4. Click and drag a box around
the survey points and
measurements you want to
list.

The Survey Explorer opens,
and a new list page is added
that contains the
measurements and points
you listed from the map.
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Filtering the type of
objects used by the List
Survey Objects tool

1. Click Survey Editor in the
Survey Editor toolbar and
click Set Survey Layers For
List.

2. Check the survey layers from
which you want to list survey
objects.

3. Check the sublayers in a
checked survey layer from
which you want to list survey
objects.

4. Uncheck the sublayers in a
checked survey layer from
which you do not want to list
survey objects.

5. Click Close.

6. Click the List Survey Objects
tool.

7. Click and drag a box around
the survey points and
measurements you want to
list.

The Survey Explorer displays
a new filtered list page
containing the measure-
ments and points within the
box you defined and stored
in the sublayers that are
checked in the Set Survey
Layers For List dialog box.

This example shows a
uniform list of survey points.
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How can you resize
columns in the list page?
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Adding list pages based
on specific survey
classes

1. Click the List Survey Objects
By Query button in the
Survey Editor toolbar.

2. Check the survey classes
from which you want to list
survey objects.

3. Click OK.

The Survey Explorer displays
a new list page containing all
the survey objects from the
classes you checked in the
List Survey Objects By Query
dialog box.

Tip

Resizing the Survey
Explorer
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What attributes are
displayed in a mixed list?
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This example shows a mixed list of
computations.
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Adding list pages based
on survey class
attributes

1. Click the List Survey Objects
By Query button in the
Survey Editor toolbar.

2. Check the survey classes
from which you want to list
survey objects.

3. Click the survey class for
which you want to refine the
list based on the class
attributes.

4. Click the Query Builder
button.

5. Double-click the field you
want to use in the query.

6. Click the logical operator you
want to use.

7. Double-click the value in the
Unique values list that you
want to use as part of the
query or type the value in the
query box.

8. Click OK on the Search
Criteria dialog box.

9. Click OK on the List Survey
Objects By Query dialog box.

The list page that is added in
this example is the set of total
station computations but
excludes traverse
computations that have been
adjusted by the compass
method.
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Verifying a query
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Adding list pages based
on projects

1. Click the List Survey Objects
By Query button in the
Survey Editor toolbar.

2. Check the survey classes
from which you want to list
survey objects.

3. Click the survey layer name.

4. Click the Survey Projects
button.

5. Click the Survey Projects
Subset option.

6. Check the projects from
which you want to list survey
objects.

7. Click OK in the Owning or
Referencing Survey Projects
dialog box.

8. Click OK in the List Survey
Objects by Query dialog box.

In this example, all survey
points belonging to or
referenced from the Carmel
Bay project will be displayed
in a uniform list.
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Selecting one or more
survey objects

1. Scroll through the list page to
find the row of the survey
object you want to select.

2. Click the row number in the
leftmost column of the list.

3. Scroll through the list to find
other objects to add to the
selection.

4. Add to the selection by
holding down the Ctrl key
while repeating step 2.

Selecting multiple survey
objects in a block of rows

1. Scroll through the list page to
find the first row in the block
of rows you want to select.

2. Click the row number in the
leftmost column of the list.

3. Scroll through the list to find
the last row in the block of
rows you want to select.

4. Hold down the Shift key and
click the leftmost column of
the list.

Tip

Removing survey objects
from the selection
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Navigating from selected
survey points to a list of
measurements

1. Select survey points in the
Survey Explorer.

2. Right-click the leftmost
column in the Survey
Explorer.

3. Click Go To Measurements.

A new list page of
computations is added to the
Survey Explorer.

Navigating from selected
measurements to their
list of computations

1. Select measurements in the
Survey Explorer.

2. Right-click the leftmost
column in the Survey
Explorer.

3. Click Go To Computations.

A new list page of
computations is added to the
Survey Explorer. In this
example, all the
measurements are used in a
single traverse computation.

Navigating
dependencies
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Navigating from selected
survey points to a list of
dependent computations

1. Select survey points in the
Survey Explorer.

2. Right-click the leftmost
column in the Survey
Explorer.

3. Click Go To Computations.

4. Check using the selected
Survey Point(s) if you want a
list of computations that use
the selected points as input.

5. Check providing coordinates
for the selected Survey
Point(s) if you want a list of
computations that target the
selected points.

6. Click OK.

A new list page of
computations is added to the
Survey Explorer.
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Navigating to
computation details

1. Select the computations in
the list for which you want to
see detail pages.

2. Right-click the leftmost
column in the list and click
Go To Details.

A new set of detail pages for
your selected computations
is added to the Survey
Explorer.

3. Click the Previous Object and
Next Object buttons to walk
through each of the detail
pages.

Navigating to
details
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Skipping to the first and
last detail pages
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Navigating to survey
point details

1. Select the survey points in
the list for which you want to
see detail pages.

2. Right-click the leftmost
column in the list and click
Go To Details.

A new set of detail pages for
your selected survey points
is added to the Survey
Explorer.

3. Click the Previous Object
and Next Object buttons to
move through each of the
detail pages.
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Changing highlighting
options

1. Click Survey Editor and click
Options.

2. Click the Highlighting tab.

3. Click the Color button to
choose a different highlight
color.

4. Click No Highlighting to turn
off all map highlighting.

5. Click Active Object to turn on
map highlighting for the
active objects only.

6. Click Objects Selected on the
List page for all selected
objects.

7. Click OK.

Map highlighting
options
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Panning to a survey point
or measurement

1. Right-click any cell of a row
for the measurement or
survey point that you want to
bring into view on the map.

2. Click Pan To.

The map extents shift so that
the survey point or
measurement is displayed in
the center of the map.

Flashing active objects

1. Right-click any cell of a row
for the measurement or
survey point that you want to
flash on the map.

2. Click Flash.

The active measurement or
survey point flashes.

Using the Active
object context
menu
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Using the Active object
context menu in a detail
page
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Zooming to an Active
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IN THIS CHAPTER

147

7
Previous chapters illustrate how to import survey data and how to display
and explore the survey points, measurements, and computations stored in
a survey dataset.

This chapter presents the computations used for coordinate geometry
(COGO), and the computations used for processing measurements from
the theodolite family of surveying equipment (TPS). You will learn the
purpose of each computation and how to apply it to define new coordinates
for survey points.

In this chapter, you will also learn how to work with the reporting
functionality available for computations.

• Editing survey data—an overview

• The Survey Editor toolbar

• Using computation detail pages

• The Survey Explorer toolbar

• Identifying computation states

• Creating a new survey point

• Preparing the computation
environment

• Using Simple COGO computations

• Using intersection computations

• Using circular curve computations

• Using the station and offset

• Using the COGO Traverse

• Exploring and using TPS
computations

• Reporting computation results

Using computations

Ch07.pmd 11/24/2003, 4:39 PM147



148 USING ARCGIS SURVEY ANALYST

Editing survey data—an overview

*����������������������
������
��������������������
�	
��	
��

�����	����������	
��
�'����
�����'����
�����1�
�=

,= ���
���
�2��=

�= ��������������	������
��
��������������=

�= �������	
��
����������
��	
��
��
� ���������
�	�������������
����������=

�= ���������	
��
��
� �������������	
����������
�	�������������
����������=

�	
��
���
�
����������	
����
�
���
���
��������������������	����=

Add the Survey
Editor and Editor
toolbars to the
map

!= ���������	
��
�'����
�����'����
�����1�
������������=

$= .���#����
��'��������������'����
����	=

New map file button

Open button

Add data button



USING COMPUTATIONS 149

*�������
������������������=�8���������������
����������������
���
����	
�����������	
�����
�1	���7�
�	�����������
��������������

�	
��
��1 �������������������1�����	
�������������������=

&= �����������
�����
� �����
���������
��
�����������������������
���������	�������������������	
��
��1 ����=

)= .
����������	
��
����������������	�������A�������(������
�	
��
����������������	�������=

+= .���#������'��������
�������'����
����	���������#�@�������
�
������������������������=

@�	��������������������������������	����=�*���������
�	�����
����������������1���������1������1��������
�	���(���������������=

C�
���
������
��������������
���������������
�2��7��������
���
��� ���!���
�
���
����.�����
�)7�E'�����������	
��������

=D



150 USING ARCGIS SURVEY ANALYST

The Survey Editor toolbar

The Target
Project dropdown

list establishes
the project to

which new
survey objects

will belong.

The Computation
tool palette

enables you to
create a new

computation and
detail page.

Survey
Editor
commands

The List Survey
Objects tool button
allows you to add
lists of points and
measurements to

the Survey
Explorer by

dragging a box.

 Feature link tools
link and unlink

feature vertices
and survey points.
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Using computation detail pages

Point identifier field
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Point identifier

Direction field
Angle field

Distance field

Deflection angle distance
computation showing
different input fields

Point identifier
field

Prefix pin

Point name flag:
point exists

Point name flag:
new point

Coordinate
geometry
computations

Total station
computations
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Angle field
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Display unit abbreviation for
decimal degree

Display unit abbreviation for
decimal gon

Subunit: degree of arc

Horizontal angles observed with a total station

Horizontal angle entered in a COGO computation

Zenith angles observed with a total station
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Direction field
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Sub unit: minute of arc

Display unit for
seconds of arc

Azimuth format

Azimuth format Display unit for
decimal degree

Quadrant bearing
format

North azimuth direction

Quadrant bearing direction
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Length and Height fields
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Length field: distance in
units of feet

Height field: standard
deviation value for
elevation in units of
meters

Height field: instrument
height in units of meters

Height and length observations for total station
measurements
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Coordinate fields
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Coordinates
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Entering values using the map
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Point field entry

Coordinate field entry

Snap and click
the survey point
you want to add
to the point
identifier field.

Text in bold
indicates that
the Point
identifier field
has focus.

Snap and click
the map location
that defines the
coordinates you
want to add to
the Easting and
Northing fields.

Easting field text
is bold.
Coordinate field
has focus.

Focus field
text is bold
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Direction field entry by the drag methodDirection field entry by the single-click method

Direction field
text is bold and
has focus.

The from point
location defines the
start of the line of
direction. Click the
location on the map
that defines the end
of the direction line.

Drag a line that
defines the
direction you want
to enter; release the
left mouse button at
any map location or
after snapping to a
known location.

Map feedback
indicates the
drag direction.
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Direction field entry by snapping to edges

Snap to the edge of a feature to
capture the direction of the edge.

Since there are two possible
directions for a segment, the direction

used is based on which end of the
segment you click closest to.

Direction of map
feedback shows to
which side of the
segment the cursor
is snapped.
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Angle field entry by dragging two directionsAngle field entry
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Angle field entry by the two-click method

Angle text is
bold and Angle
field has focus.

Click two locations
on the map, so that
the apex at the from
point location
defines the angle
you want to enter.
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Distance field entry by the click method

Distance field entry by snapping to edges

Distance field entry by the drag method

Bold text indicates
that the Distance
field has focus.

Bold text indicates
that the Distance
field has focus.

Distance matches
the length of the
snapped feature
segment.

Drag out a distance.
You can snap to
feature geometry or
survey points.
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The Survey Explorer toolbar

Lets you step to
the previous

page

Lets you step to
the next page

Computes the active
computation

Computes the
computations
selected in a list
page

Computes the active
computation and all of
its dependent
computations

Survey Explorer with its toolbar docked

Deletes the active
object

Adds a new detail page of
the same type as the

active page
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Identifying computation states

Computation
state: valid

Point identifier
field is not
complete

Computation
state: incomplete

Computation
state: out-of-
date

Computation
state: incorrect

Identical directions
do not intersect
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Creating a new
survey point
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Typing coordinates for a
new survey point

1. Start ArcMap, add the Editor
toolbar, and add the Survey
Editor toolbar.

2. Add to the map the survey
project in which you want to
create a survey point.

3. Click the Editor menu in the
Editor toolbar and click Start
Editing.

4. Click Snapping in the Editor
menu and click Survey Points
in the Snapping Environment
dialog box.

5. Click the Project dropdown
arrow in the Survey Editor
toolbar, then click the survey
project that should own the
new survey point.

6. Click the Computation tool
palette dropdown arrow,
move the cursor to the first
row of buttons on the palette,
and click the XY tool. �

�

�

�
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7. Type a name for the point if
you do not want to use the
default name.

8. Press Tab.

9. Type the Easting value into
the first coordinate field.

10. Press Tab.

11. Type the Northing value into
the second coordinate field
and press Tab.

12. If an elevation is available,
type an Elevation value into
the third coordinate field and
press Enter.

The new survey point is
added into the survey
dataset.

13. Skip steps 13—16 if you do
not want to add standard
deviations for the survey
point coordinates.

14. Click the Quality tab

15. Type a standard deviation
value for Position and press
Tab.

16. Type a standard deviation
value for Elevation.

17. Press Enter.

The new survey point has
standard deviations
assigned.

See Also
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New Object button
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Digitizing a sequence of
new survey points

1. Click Snapping in the Editor
menu and click Survey Points
in the Snapping Environment
dialog box.

2. Click the Project dropdown
arrow in the Survey Editor
toolbar, then click the survey
project that should own the
digitized survey points.

3. Click the Computation tool
palette dropdown arrow,
move the cursor to the first
row of buttons on the palette,
and click the XY tool. If a
detail page for the XY tool is
open, click the new object
button.

4. Type a name for the point if
you do not want to use the
default name. Press Tab.

5. Click the map at the location
where you want to digitize a
new survey point.

6. Click the New Object button.
Repeat steps 4 and 5 for
each new digitized survey
point.

Tip

Autocomplete
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Preparing the
computation
environment
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Display units
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Setting the display units

1. Click the Tools menu and
click Options.

2. Click the Survey
Measurement Formats tab.

3. Click the Defined Formats
dropdown arrow and click the
unit type for which you want
to set the display.

4. Click the unit in the units list.

5. Verify the name in the Format
Details box to make sure it is
the unit that you want to use.

6. Type the Precision for the unit
by entering the number of
decimal places to display.

7. Click the Set As Display
Format button.

8. Click OK.
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Defining an angle
correction and distance
scale factor for COGO
computations
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Creating a custom display
unit

1. Click the Tools menu and
click Options.

2. Click the Measurement
Formats tab.

3. Click the Defined Formats
dropdown arrow and click
the unit type for which you
want to create a custom unit.

4. Click the unit in the units list
on which you want to base
the custom unit.

5. Check Advanced.

6. Click the New button.

7. Type a name for the new unit
in the Name text box and
press Tab.

8. Type the Precision for the
unit by entering the number
of decimal places to display.
Press Tab.

9. Type the number of units per
master unit. (In this example
it is the number of units per
meter.)

10. Click Tab and type an
abbreviation for the unit.

11. Click the Set As Display
Format button.

12. Click OK.
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Automated point naming
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Defining a correction angle
for COGO computations

1. Click the Tools menu and
click Customize.

2. Click the Commands tab.

3. Click Survey Editor in the
Categories list.

4. Drag and drop the Direction
Angle Correction command
onto the Survey Editor
toolbar. Close the Customize
dialog box.

5. Click the Editor menu in the
Editor toolbar and click Start
Editing.

6. Click the Project dropdown
arrow in the Survey Editor
toolbar, then click the survey
project for which you want to
change the correction angle.

7. Click the Direction Angle
Correction button. The
Direction Angle Correction
Tool dialog box appears.

8. Verify that the correction
angle will be applied to the
correct survey project.

9. Drag a direction on the map.
The direction value is added
to the Reference Direction
field. You can alternatively
type a Reference Direction
value. �

See Also
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10. Type the value in the
Relative Direction field. The
Correction Angle field is
updated.

11. Click Apply to Project.

The Direction Angle Correc-
tion Tool dialog box is closed
automatically.

12. Click Editor in the Editor
toolbar, and click Save Edits.
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Using a point naming
increment

1. Click Survey Editor in the
Survey Editor menu and click
Options.

2. Click the Points tab.

3. Type the alpha portion of the
default point name in the
Start Point text box.

4. Type the increment for the
numerical portion of the
name in the Increment text
box.

5. Verify that the Next Point
Name is as expected based
on your choices.

6. Click OK.
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Automate referencing the
GIS coordinate in
computations

1. Click Survey Editor in the
Survey Editor menu and click
Options.

2. Click the Points tab.

3. Click copy the GIS coordi-
nate and make it current.

4. Click OK.

Automate referencing the
current coordinate of the
owning project

1. Click Survey Editor in the
Survey Editor menu and click
Options.

2. Click the Points tab.

3. Click copy the current
coordinate of the owner
survey project.

4. Click OK.

Automated behavior for
survey point referencing
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Using simple
COGO
computations

Delta XY
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Computing a coordinate
using delta x,y values

1. Click Snapping in the Editor
menu and click Survey Points
in the Snapping Environment
dialog box.

2. Click the Project dropdown
arrow in the Survey Editor
toolbar. Click the survey
project that should own the
delta values, the survey point
coordinate, and the
computation.

3. Click the Computation tool
palette dropdown arrow,
move the mouse to the first
row of buttons on the palette,
and click the Delta XY button.

4. Snap to and click the from
point on the map. The name
of the point appears in the
From Point field. If the point is
not visible on the map, type
its name and press Tab.

5. Type the Delta X value and
press Tab.

6. Type the Delta Y value and
press Tab.

7. Create a name for the point if
you do not want to use the
default name. Press Enter.
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Completed Delta XY computation
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Direction Distance
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Computing a coordinate
using a direction and a
distance from a known point

1. Click Snapping in the Editor
menu and click Survey Points
in the Snapping Environment
dialog box.

2. Click the Project dropdown
arrow in the Survey Editor
toolbar and click the survey
project that should own the
direction and distance
values, the survey point
coordinate, and the
computation.

3. Click the Computation tool
palette dropdown arrow,
point the mouse to the first
row of buttons on the palette,
and click the Direction
Distance button.

4. Snap to and click the from
point on the map. The name
of the point appears in the
From Point field. If the point is
not visible on the map, type
its name and press Tab.

5. Type the Direction value and
press Tab.

6. Type the Distance value and
press Tab.

7. Type a name for the new
point if you do not want to
use the default name, then
press Enter.
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Completed Direction Distance computation
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Deflection-Angle-
Distance
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Computing a coordinate
using a reference direction,
angle offset, and a distance
from a known point

1. Click Snapping in the Editor
menu and click Survey Points
in the Snapping Environment
dialog box.

2. Click the Project dropdown
arrow in the Survey Editor
toolbar, then click the survey
project that should own the
measurement, point, and
computation survey objects.

3. Click the Computation tool
palette dropdown arrow,
point the mouse to the first
row of buttons on the palette,
and click the Deflection-
Angle-Distance button.

4. Snap to and click the from
point on the map. The name
of the point appears in the
From Point field. If the point is
not visible on the map, type
its name and press Tab.

5. Type the Reference Direction
and press Tab.

6. Type the Angle value and
press Tab.

7. Type the Distance value and
press Tab.

8. Type a name for the point if
you do not want to use the
default name. Press Enter.
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Deflection-Angle-Distance computation
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Using
intersection
computations

Intersecting two
distances
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Computing a coordinate
using intersection of
distances

1. Click Snapping in the Editor
menu and click Survey Points
in the Snapping Environment
dialog box.

2. Click the Project dropdown
arrow in the Survey Editor
toolbar and click the survey
project that should own the
measurements, points, and
computations.

3. Click the Computation tool
palette dropdown arrow,
point the mouse to the
second row of buttons on the
palette, and click the
Distance–Distance button.

4. Snap to and click the first
point on the map. The name
of the point appears in the
First Point field. If the point is
not visible on the map, type
its name in the text box and
press Tab.

5. Type the distance from the
first point and press Tab.

6. Repeat step 4 for the second
point.

7. Type the distance from the
second point and press Tab.

8. Press L if you want the left
solution or press R for the
right solution, then press Tab.

9. Type a name for the point if
you do not want to use the
default name. Press Enter.
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Completed Distance-Distance
intersection computation
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Intersecting a direction
and distance
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Computing a coordinate
using an intersection of a
distance and a direction

1. Click the Computation tool
palette dropdown arrow,
point the mouse to the
second row of buttons on the
palette, and click the
Direction-Distance-
Intersection button.

2. Snap to and click the first
point on the map. The name
of the point appears in the
First Point field. If the point is
not visible on the map, type
its name in the text box and
press Tab.

3. Type the direction value and
press Tab.

4. Repeat step 2 for the second
point.

5. Type the distance value and
press Tab.

6. Using the keyboard, press
the F key to select the first
solution or the S key to select
the second solution.

7. Press Tab.

8. Type a name for the Result
Point if you do not want to
use the default name and
press Enter.
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Direction-Distance-Intersection
computation



USING COMPUTATIONS 177

Computing a coordinate
using intersection of
directions with offsets

1. Click the Computation tool
palette dropdown arrow,
point the mouse to the
second row of buttons on the
palette, and click the
Direction-Direction-
Intersection button.

2. Snap to and click the first
point on the map. The name
of the point appears in the
First Point field. If the point is
not visible on the map, type
its name in the text box, and
press Tab.

3. Check Use Offset.

4. Type the direction in the
Direction field and press Tab.

5. Type the Offset distance from
the first direction.

6. Repeat step 2 for the second
point.

7. Repeat step 4 for the second
direction.

8. Repeat step 5 for the offset
distance from the second
direction.

9. Type a name for the point if
you do not want to use the
default name, and press
Enter.
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Intersecting two
directions
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Completed Direction-Direction-
Intersection computation
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Using circular
curve
computations

Circular curve
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Computing coordinates
from a circular curve’s
chord direction, arc length,
and radius

1. Click the Computation tool
palette dropdown arrow,
point the mouse to the third
row of buttons on the palette,
and click the Circular Curve
button.

2. Snap to and click the from
point on the map. The name
of the point appears in the
From Point field. If the point is
not visible on the map, type
its name and press Tab.

3. Click the Reference Direction
dropdown arrow, click Chord
and press Tab.

4. Type the direction value and
press Tab.

5. Click the First parameter
dropdown arrow, click Arc
Length, and press Tab.

6. Type the arc length value
and press Tab.

7. Click the Second parameter
dropdown arrow, click
Radius, and press Tab.

8. Type a length for the radius
of the circular arc and press
Tab.��
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Circular curve computation
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9. Click the Solution dropdown
arrow and click Left to
choose the left solution, or
click Right to choose the right
solution.

10. Accept the default name, or
type a new name, and press
Tab.

11. Follow steps 12 and 13 if
you want to compute
coordinates and create a
center point for the circular
curve.

12. Click the Create Center
Point check box.

13. Accept the default center
point name, or type a new
point name and press Enter.

Arc
length Chord

length

Tangent
length

Half delta
angle

Right
solution


 	

��



180 USING ARCGIS SURVEY ANALYST

,�������������� ���� �� 
����� 
��
"����	���� ���� ���������� �����

���
����� �	!��-

. 8�
���

. ����


.  ������

 ����� 
���
������ ���� ��"$�
�� ��
������� ��� ������ 
����
����
�!!���
� ��� ���������

��!������ ���� 
���
�������
 ��� ������� ��� ���� 
���
������ ��
������
� ���� �����
� ��� ���� �����	

�������� �

Computing coordinates from
a circular curve’s  radial
direction, chord length, and
delta angle

1. Snap to and click the from
point on the map. The name
of the point appears in the
From Point field. If the point is
not visible on the map, type
its name in the text box, then
press Tab.

2. Click the Reference Direction
To/Of dropdown arrow, click
Radial, then press Tab.

3. Type the direction value and
press Tab.

4. Click the First parameter
dropdown arrow, click Chord,
and press Tab.

5. Type the chord length value
and press Tab.

6. Click the Second parameter
dropdown arrow, click Delta,
and press Tab.

7. Type an angle value for the
central angle of the circular
arc and press Tab.

8. Click the Solution dropdown
arrow and click Left to
choose the left solution, or
click Right to choose the right
solution.

9. Accept the default name or
type a new name and press
Tab.

Chord
direction

Radial
direction

Tangent
direction

� � �
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Circular curve computation
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Fillet curve
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Computing coordinates
using a Fillet curve

1. Click the Computation tool
palette dropdown arrow,
point the mouse to the third
row of buttons on the palette,
and click the Fillet Curve
button.

2. Snap to and click the from
point on the map. The name
of the point appears in the
First Point field. If the point is
not visible on the map, type
its name in the text box and
press Tab.

3. Type the first direction and
press Tab.

4. Repeat step 2 for the second
point.

5. Type the second direction
and press Tab.

6. Type the radius for the fillet
and press Tab.

7. Accept the default name for
the first result point or type a
new name, then press Tab.

8. Repeat step 7 for the second
result point.

�
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Fillet curve computation

First direction

Second
direction

Radius
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Using the station
and offset
computation
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Computing coordinates
evenly spaced on a line
between two existing
points

1. Click Snapping in the Editor
menu and click Survey Points
in the Snapping Environment
dialog box.

2. Click the Project dropdown
arrow in the Survey Editor
toolbar, then click the survey
project that should own the
measurement, point, and
computation survey objects.

3. Click the Computation tool
palette dropdown arrow,
move the cursor to the fourth
row of buttons on the palette,
and click the Station and
Offset button.

4. Snap to and click the from
point on the map. The name
of the point appears in the
From Point field. If the point is
not visible on the map, type
its name, and press Tab.

5. Repeat step 4 to define the
To Point and press Tab.

6. Click the Stationing Type
dropdown arrow, click
Spaced evenly, then press
Tab.

7. Type the number of equal
segments you want to use to
divide the line and press Tab.
The grid updates with a new
row for each of the new
points.��
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8. Press Tab to ignore offset
distances, press Tab to
accept the default name, or
type a new name and press
Tab.

9. Repeat step 8 for each of the
new points in each row.

Computing points on line between points
SP12 and SP13

From point

To point

Varying
distances

Equal
distances



184 USING ARCGIS SURVEY ANALYST

Computing coordinates
offset left and right from
a line between two points

1. Click the Computation tool
palette dropdown arrow,
point the mouse to the fourth
row on the palette, and click
the Station and Offset button.

2. Snap to and click the from
point on the map. The point
name appears in the From
Point field. If the point is not
visible on the map, type its
name in the text box. Press
Tab.

3. Repeat step 2 to define the
To Point and press Tab.

4. Click the Stationing Type
dropdown arrow and click
Variable distances. Press
Tab.

5. Type the distance along the
line measured from the
previous point and press Tab
(the first distance starts at the
from point).

6. Type the first perpendicular
offset distance in the Offset
field. Press Tab.

7. Accept the default name in
the point identifier field or
type in the new name. Press
Enter.

8. Repeat steps 5–7 for each
distance and offset along the
line that you want to enter.

 ��	� 
��� "�� 
��!���
� ��� �#���

�����
��� ������ ���� !����� ��

���	���� 
�����
���� ��� ��� ����
���	� 
���
�� ���� ������ !���� ����
���!�
���
����"�������#���
����������

Tip

Computing line offsets
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Computing coordinates offset from a line

Equal
divisions
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Proportioning the
remainder when
computing points on line

1. Start a new station and offset
computation.

2. Choose the From Point and
To Point.

3. Click the Stationing Type
dropdown arrow. Click
Variable distances and press
Tab.

4. Type the distance along the
line measured from the
previous point in the Value
field and press Tab (the first
distance starts at the from
point).

5. Type an offset value, if
required, and press Tab.

6. In the Point identifier field,
accept the default name or
type in the new name and
press Enter.

7. Repeat steps 4–6 for each
distance and offset along the
line that you want to enter.

8. Check Proportion after you
have entered the closing
distance.

The points are recomputed;
the remainder is distributed
equally in each of the
original distance
measurements.

�
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Proportioning the remainder for points on line
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Computing coordinate
locations along a feature
segment path

1. Identify the connected feature
segments along which you
want to create new survey
points.

2. Unless they already exist,
digitize two new survey
points, snapping to the first
and last feature vertices that
define the segment path.

3. Start a new station and offset
computation.

4. Click Editor in the Editor
toolbar and click Snapping.

5. Check Edge for the feature
class that represents the
feature that holds the feature
segment path. �
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6. Make sure the From Point or
To Point field has focus, snap
to, and click a segment on
the path.

The points at the beginning
and end of the path are
added to the point fields.

7. Click the Stationing Type
dropdown arrow, click the
method you want to use, then
press Tab.

8. Enter point names,
distances, and offsets, if
required.

See Also
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Point computed along a feature segment
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Using the COGO
Traverse
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Computing coordinate
locations using a Bearing
COGO traverse

1. Click Snapping in the Editor
menu and click Survey Points
in the Snapping Environment
dialog box.

2. Click the Project dropdown
arrow in the Survey Editor
toolbar and click the target
survey project.

3. Click the Computation tool
palette dropdown arrow,
point the mouse to the fourth
row on the palette, and click
the COGO Traverse button.

4. Type a name for the compu-
tation and press Tab.

5. Type a comment for the
COGO traverse computation
and press Tab.

6. Click Bearing.

7. Type the maximum allowable
limit for the misclosure in
easting and northing.

8. Type the maximum allowable
Relative Error as a
percentage. �
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9. Click the Parameters tab.

10. Snap to and click the start
point on the map. The point
name appears in the Start
Point field. If the point is not
visible on the map, type its
name and press Tab.

11. If you are doing an open
traverse, press Tab, and skip
to step 13.

12. Repeat step 10 for the
endpoint of the traverse.

13. Double-click the TR/SS field,
click SS to choose the next
course as a side-shot, or
choose TR if the next course
is part of the main traverse.

14. Press Tab.

15. Press Tab to accept the
default To Point name. If you
are entering the final course
for a closed traverse,
double-click the To Point
field, and type the endpoint
name. Press Tab.

16. If the course you are
entering is a circular curve,
skip to step 18. Otherwise,
continue to step 17.

17. Double-click the Direction
field, click ST, press Tab,
then skip to step 19.

18. Double-click the Direction
field and click the type of
direction for the circular
curve. Press Tab.  �

Tip

Keyboard shortcut for
curve parameters
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Open traverse

Side-shot
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Tangent

Radial
Chord

Straight line

Side-shot
or traverse
course

Traverse

Side-shot

Radius

Half delta
angle

Second curve
parameter

Arc length

Delta angle

Chord length

First curve
parameter
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19. Type the direction value and
press Tab.

20. Skip to step 23 if the course
you are entering is a circular
curve. Otherwise, continue
with steps 21 and 22.

21. Accept the distance param-
eter type (DI) and press Tab.

22. Type the distance value for
the course and skip to step
28.

23. Double-click the Curve
Parameter 1 (CP1) field and
click the first parameter type.
Press Tab.

24. Type the value of the first
parameter. Press Tab.

25. Double-click the Curve
Parameter 2 (CP2) field and
click the first parameter type.
Press Tab.

26. Type the value of the second
parameter. Press Tab.

27. Double-click the solution
field and click the direction
in which the circular curve
bends.

28. Press Enter.

29. Repeat steps 13 through 28
for each of the courses in the
traverse.

See Also
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Closed traverse from point C1.101 to point C1.102

Closed loop traverse
Curve
direction
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Adjusting the closure
error in a closed COGO
traverse

1. Click the Adjustment tab.

2. Click the Method dropdown
arrow and click the method
you want to use to adjust the
error.

3. Click the Compute button.

The adjusted values and
their residuals are displayed.

Tip

Computing an area with a
COGO traverse
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Closure
error
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Computing coordinates
using an open Angle
Right COGO traverse
with straight line courses

1. Click the Computation tool
palette dropdown arrow,
move the mouse to the fourth
row on the palette, and click
the COGO Traverse button.

2. Type a name for the
computation and press Tab.

3. Type a comment for the
COGO traverse computation
and press Tab.

4. Click Angle Right as the
Angle Format. �

��



USING COMPUTATIONS 193

5. Click the Parameters tab.

6. Snap to and click the start
point on the map. If the point
is not visible on the map,
type its name in the text box,
and press Tab.

7. Press Enter to ignore the
endpoint.

8. Repeat step 6 to choose the
Backsight Point.

9. Press Enter to accept the
default backsight Direction
value.

10. Press Enter to ignore the
Foresight Point.

11. Press Enter to ignore the
foresight direction value.

12. Press Enter to accept the TR
parameter.

13. Press Enter to accept the
default To Point name, or
else double-click in the field
to type a different point
name and press Enter.

14. Press Enter to accept the
default Angle parameter
(ST).

15. Type an angle value and
press Enter.

16. Press Enter to accept the
CP1 (DI).

17. Type the distance value and
press Enter.

18. Repeat steps 12–17 for each
traverse course.
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Angle Right COGO traverse
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Exploring TPS computations
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The General tab
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Detail of TPS computation, showing the General tab
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The Setup tab
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The Measurements tab
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The Computed Points tab
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Using the TPS
computations
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Processing a single TPS
setup using Tacheometry

1. Click the Project dropdown
arrow in the Survey Editor
toolbar and click the survey
project that should own the
new computation.

2. Click Editor on the Editor
toolbar and click Snapping.

3. Check Survey Points.

4. Click the Computation tool
palette dropdown arrow,
move the mouse to the last
row on the palette, and click
the Tacheometry button.

5. Type a name for the
computation and press Tab.

6. Type a comment for the
tacheometry computation
and press Tab.

7. Type the limits you will allow
for the standard deviation of
the orientation. �

�

�

�

�

�



USING COMPUTATIONS 199

8. Click the Setup tab.

9. Snap to and click the setup
point on the map. If the point
is not visible on the map,
type its name in the text box
and press Tab.

10. Click the Setup Name
dropdown arrow and click
the name of the setup you
want to process.

11. Click the Value field for the
Setup Name attribute if you
want to change the name of
the setup and type a new
name.

12. Repeat step 11 if you want
to change the stored
attributes for Instrument
Height, Date, or Comment.

13. Click the Measurements tab
and resize the Survey
Explorer if needed.

14. Check the reference points
you want to use for
orientation.

15. Click the Compute button.

16. Verify that the computation
was processed successfully
by ensuring the state is
valid. �
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17. Click the Overview tab to
see the orientation and its
standard deviation.

18. Click the Details tab to see
the orientation and residuals
for each of the reference
points.

The Orientation field is the
direction of the zero reading
on the horizontal circle of the
TPS instrument.

19. Click the Computed Points
tab to view the coordinates
computed.

�

Computing a tacheometry for bulidings

��
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Processing a single TPS
setup using a Free Station
Computation

1. Click the Computation tool
palette dropdown arrow,
move the cursor to the last
row on the palette, and click
the Free Station button.

2. Type a name for the
computation and press Tab.

3. Type a comment for the
computation and press Tab.

4. Type the limits you will allow
for the standard deviation of
the orientation.

5. Click the Setup tab.

6. Snap to and click the setup
point on the map. If the point
is not visible on the map,
type its name and press Tab.

7. Click the Setup Name
dropdown arrow and click
the name of the setup you
want to process. �

Free Station
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8. Click the Measurements tab
and resize the Survey
Explorer if needed.

9. Check the reference points
you want to use for
orientation.

10. Click the Compute button.

11. Verify that the computation
was processed successfully
by ensuring the state is
valid.

12. Click the Overview tab in the
results section to see the
computed coordinates and
their standard deviations.
The orientation and its
standard deviation is also
reported.� �

Free station computation. St10 and St09 are used
as references to calculate coordinates for FR01.
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13. Click the Details tab to see
the orientation and residuals
for each of the reference
points.

The Orientation field is the
direction of the zero reading
on the horizontal circle of the
TPS instrument.

14. Click the Computed Points
tab to view the coordinates
computed.

�
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Processing multiple TPS
setups using a Traverse
Computation

1. Click the Computation tool
palette dropdown arrow,
move the mouse to the last
row on the palette, and click
the Traverse button.

2. Type a name for the
computation and press Tab.

3. Type a comment for the
traverse and press Tab.

4. Type the limits you will allow
for lateral and lengthwise
misclosure.

5. Type the limits you will allow
for the standard deviation in
the horizontal position,
elevation, and orientation.

6. Check Compute Tacheometry
for every Traverse Station if
you want to compute all the
side-shots.

This option will automatically
process each instrument
setup as a tacheometry
computation after the initial
traverse has been
computed. �

Traverse
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7. Click the Setup tab.

8. Click the Point identity field in
the Setup Point field.

9. Snap to and click the setup
point on the map. If the point
is not visible on the map, type
its name and press Tab.

10. Double-click the Setup field
dropdown arrow in the text
box and click the name of
the setup you want to use for
the traverse. Press Tab.

11. Check the box in the fixed
field (if available) if you want
to use the setup point as a
reference point.

Checking this field will not
compute new coordinates for
this point.

12. Press Enter.

13. Repeat steps 9–12 for each
instrument setup that you
want to process in the
traverse.

14. Click the Measurements tab.

15. Click the Setup dropdown
arrow and click the name of
the setup with which you
want to work.

The measurements detail for
the selected setup is
displayed.

16. Click the Results / Method
dropdown arrow and select
the adjustment method.

17. Click the Compute button. u

The Crandall method distributes
the error in the distances only,
assuming observed angles have
no measurement error.

You can define the allowable
limits for the closure error in the
traverse in terms of its
lengthwise misclosure and
lateral misclosure.

These elements are depicted in
the graphic below.

Lateral
closure
error (Q)

Lengthwise
closure
error (L)

The formulae used for
determining the values of L and
Q are:
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18. Verify that the computation
was processed successfully
by ensuring the state is
valid.

19. Click the Traverse Overview
tab to see the coordinate
misclosures. In the overview
you can also see the
angular, linear, latitude, and
departure  misclosures.

20. Click the Traverse Details
tab to see the coordinated
locations defined by the
traverse.

The changes from the
initially computed coordi-
nates and the coordinates
after the adjustment are
shown in the the Delta East
and Delta North fields.

21. Click the Tacheometry
Overview tab and the
Tacheometry Details tab to
view the results of the
tacheometry computation for
this setup.

See Also
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TPS field traverse computation
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Typing measurements from
a field book—an example
based on the Resection

1. Click the Computation tool
palette dropdown arrow,
move the mouse to the last
row on the palette, and click
the Resection button.

2. Type a name for the
computation, and press Tab.

3. Type a comment for the
traverse and press Tab.

4. Type the limits you will allow
for the standard deviation in
the horizontal position,
elevation, and orientation.

5. Click the Setup tab.

6. Click the Point identity field
for the Setup Point, type a
name for a new survey point,
and press Tab.

7. Type a name for the setup
and press Tab.

8. Complete the properties for
the Setup Details. �

Resection
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9. Click the Measurements tab.

10. Snap to and click the
observed point name on the
map. If the point is not visible
on the map, type its name in
the text box and press Tab.

11. Check the Orientation box if
the observed point is a
reference point. Press Tab.

12. Type an angle value in the
HzAngle field. Hold down
Ctrl and press Enter.

The focus goes to the last
field. Press Enter.

13. Repeat steps 10–12 to add
new rows for each entry from
the field book.

14. Click the Compute button.

Resection computation

�
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Processing multiple TPS
setups using a Least
squares adjustment

1. Click the Computation tool
palette dropdown arrow,
move the mouse to the last
row on the palette, and click
the Adjustment button.

2. Type a name for the
computation and press Tab.

3. Type a comment for the
adjustment and press Tab.

4. Type the a priori standard
deviation for the horizontal
angle observations and
press Enter.

5. Repeat step 4 for the vertical
angle observation.

6. Type the standard deviation
for the distance, press Tab,
and enter the parts per
million ratio. Press Enter.

7. Type the a priori standard
deviation for centering the
setup. Press Enter.

8. Repeat step 7 for the
standard deviations of Target
Centering, Instrument Height,
and Target Height.

9. Click the Level Of
Significance Alpha dropdown
arrow and click the alpha
percentage you want to use.

10. Click the Quality Beta
dropdown arrow and click
the beta value you want to
use. �

Least squares
adjustment
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11. Click the Setup tab.

12. Snap to and click the setup
point on the map. If the point
is not visible on the map,
type its name and press
Enter.

13. Press Enter.

14. Skip to step 16 if the correct
setup name appears in the
Setup field.

15. Double-click the Setup field
dropdown arrow and click
the name of the setup you
want to use for the traverse.
Press Enter.

16. Repeat steps 12–15 for each
instrument setup that you
want to process in the
adjustment.

17. Make corrections to the
Setup Name, Instrument
Height, and Comment, if
required. �

Tip

Setups on the same point
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Least squares adjustment computation
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Editing measurements
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18. Click the Measurements tab.

19. Click the Setup dropdown
arrow and click the instru-
ment setup name to view the
measurements belonging to
the different instrument
setups.

20. Make corrections to the
measurements, if necessary,
by editing their values. Only
do this if you know the
existing values are mistakes
and if you are absolutely
certain of the correct value. �
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21. Click the Reference Points
tab.

22. Click the Free network
adjustment option.

23. Highlight the Point Name
field in the first row by
clicking in the field.

24. Snap to and click the
reference point on the map.
If the point is not visible on
the map, type its name in the
text box and press Enter.

25. Skip to step 28 if the
reference point should be
used as control in three
dimensions.

26. Double-click the Fixed Type
field to get the Fixed Type
dropdown arrow.

27. Click the dropdown arrow
and click the dimension to
be used for the reference
point.

28. Press Enter.

29. Repeat steps 24–28 for each
reference point that should
be added to the least
squares adjustment. �

Tip

Choosing a dimension
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Statistical Testing
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30. Click the Compute button.

31. Assess the state of the
computation by looking at
the State icon.

32. Follow the steps outlined in
the next section, ‘Detecting
and disabling outlier
measurements using data
snooping’, if the icon state
indicates that the computa-
tion is incorrect. Continue
with step 33 once you have
completed the datasnooping
process.

33. Click the Results tab.

34. Click the Adjusted Objects
dropdown arrow and click
Points to view the computed
coordinates and their quality
information. �
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Tip

Original measurement
values do not change
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35. Click the Adjusted Objects
dropdown arrow and click
Measurements to view the
adjusted measurement
values. You can also view the
deltas, which provide the
amount of change from the
original unadjusted values.
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The F-test
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The W-test and
datasnooping
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Detecting and disabling
outlier measurements using
datasnooping

1. Complete steps 1–29 defined
in the preceding task,
‘Processing multiple TPS
setups using a least squares
adjustment’.

2. Click the Compute button.

3. Assess the state of the
computation by looking at the
State icon.

4. Continue with the following
steps if the icon state
indicates that the computa-
tion is incorrect; otherwise,
you do not need to disable
outlier measurements.

5. Click the Test-Statistics tab to
start the data snooping
process.

6. Click the Test Type dropdown
arrow and click Suspected
outliers in measurements.

7. Click the Setup Name
dropdown arrow and click
the different setup names to
view their outlier
measurements.

8. Identify the measurements
that have the largest
estimated error for angles
and distances and note their
setup point and to point
names for the next
few steps. ��
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9. Click the Test Type dropdown
arrow and click W-Test
Measurements.

10. Click the Setup Name
dropdown arrow and click
the setup points you noted in
step 8.

11. Find the outlier measure-
ments highlighted in red,
and identify the largest W-
Test value.

12. Click the leftmost column of
the row with the largest W-
Test value. This selects the
measurement’s row.

13. Right-click the selected row’s
leftmost column and click
Disable Measurement. Do
not disable more than one
measurement at a time.

14. Return to step 2.

Tip

Disabling measurements
����,/��������������
����������
��
��
�������������
�������������
��������������
����
������
��
������
������

���������������

���������
��

������
�����������
���
���

	




�

�

�



USING COMPUTATIONS 217

Setting Quality Beta
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Reporting
computation
results
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Creating a computation
report

1. Confirm that the state of the
computation is valid.

2. Click the Report tab.

3. Click the Style Sheet
dropdown arrow and click the
stylesheet that you want to
use.

4. Click Browse and navigate to
the location of the style sheet
if the style sheet you need is
not listed.

5. Skip to step 16 if you want to
use a predefined style.

6. Check the boxes of the items
in the computation you want
included in the report.

7. Click the element of the
computation for which you
want to change the font.

8. Double-click the Value field
for the Font property you
want to change.

9. Click the font property’s
dropdown arrow and click the
property you want to use.

10. Repeat steps 7–9 for all
other elements you want to
change.

11. Click Preview to see how the
report will appear based on
your style changes.

12. Click the Close button. �

Tip

Displaying report headings
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13. Return to step 6 if you want
to make changes.

14. Click Save Style.

15. Type a name for the new
style and click OK.

16. Click the Style dropdown
arrow and click the style you
want to use for the report. �
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17. Click Save Report.

18. Navigate to the folder in
which you want to save the
report.

19. Type a name for the report.

20. Click Save.
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Editing feature geometry 8
• Using the edit sketch

• Using COGO computations with
the edit sketch

• Linking survey points to feature
geometry

• Breaking links between survey
points and features

• Updating features

Survey points provide a framework of control for the geometry of features.
The focus of this chapter is editing features based on the map location of
existing survey points. You can choose to have the geometry of features in
survey-aware feature classes managed in this control framework.

A survey-aware feature class can be edited in the following ways:

• New features can be digitized by snapping to the geometry of survey
points.

• Existing features can be linked to survey points. An association between
survey points and features is created; feature locations are not updated
immediately.

• Existing features that are linked can be updated to match the geometry
of the survey points.

• Unlinked feature geometry can be updated based on the transformation
parameters determined by the existing links.

First, an overview of standard feature digitizing is presented, based on
starting and finishing an edit sketch. Second, the indirect method of creating
an edit sketch using COGO computations is introduced. Finally, the tools
and commands used for creating and managing links are described.

Ch08.pmd 11/24/2003, 4:44 PM221
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Using the edit
sketch
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Adding tasks to the
Editor’s task list

1. Start ArcMap and add the
Editor toolbar.

2. Click the Editor menu in the
Editor toolbar and click Start
Editing.

3. Click the Editor menu in the
Editor toolbar and click
Options.

4. Click the Edit Tasks tab.

5. Click Create Group.

6. Click the New Group in the
tasks list and click Add.

7. Click <none> and, while
holding down the Shift key,
click Select Features Using a
Line.

8. Click OK on the Add Tasks
dialog box.

9. Click OK on the Editing
Options dialog box.

See Also
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Before working with the edit
sketch and using the edit tasks,
you need to add the tasks that
you will use to the Editor
toolbar’s task list. In the Editor
options you can choose and
add tasks that are not part of
the default set. The Survey
Analyst extension uses a task
that needs to be added to the
default list. This is the <none>
task; its purpose is described in
the next section, ‘Using COGO
computations with the edit
sketch’, in this chapter.

Snapping allows you to
precisely digitize sketch points
based on the location of
existing geometry.

The Editor lets you control how
to digitize sketch points by
turning on snapping for:

• Selected elements of feature
geometry

• The points and segments of
the sketch itself

• Survey points

These snapping properties
define the snapping
environment.

Select features using a
sketch line

1. Start ArcMap, add the Editor
toolbar, and add the Survey
Editor toolbar.

2. Click the Editor menu in the
Editor toolbar and click Start
Editing.

3. Click the Task dropdown
arrow in the Editor toolbar
and click Select Features
Using a Line.

4. Click the Sketch tool.

5. Construct a line by clicking
on the map for each vertex,
so that the line intersects the
features you want to select.

6. Right-click the map and click
Finish Sketch to apply the
task and select the features.

�
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Subdividing a selected
feature

1. Click the Edit tool.

2. Click the polygon feature that
you want to subdivide.

3. Click the Sketch tool.

4. Click the Task dropdown
arrow in the Editor toolbar
and click Cut Polygon
Features.

5. Construct a sketch line that
you want to use to subdivide
the selected feature.

6. Right-click the map and click
Finish Sketch to apply the
task and cut the selected
feature.

�
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Creating a new feature by
snapping to survey
points

1. Click the Editor menu and
click Snapping.

2. Check Survey Points in the
Snapping Environment
dialog box.

3. Click the Task dropdown
arrow in the Editor toolbar
and click Create New
Feature.

4. Click the Target dropdown
arrow and click the feature
layer in which you want to
create the new feature.

5. Click the Sketch tool.

6. Construct a sketch by
snapping the sketch points to
the survey points.

7. Right-click the map and click
Finish Sketch to apply the
task and create the new
feature.

Tip

Auto-Linking survey points
When snapping edit sketch vertices
to survey points, links are
automatically created. If you do not
require these links, turn off the
Auto-Linking option in the Survey
Editor menu.
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Using COGO
computations
with the edit
sketch
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Create a new feature
using a COGO traverse

1. Click the Editor menu and
click Snapping.

2. Check Survey Points in the
Snapping Environment
dialog box.

3. Click the Target dropdown
arrow and click the feature
layer in which you want to
create the new feature.

4. Click the Task dropdown
arrow in the Editor toolbar
and click Create New
Feature.

5. Click the Sketch Tool. �

See Also
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6. Snap and click the first sketch
point to the start point of the
traverse.

7. Click the Computation tool
palette dropdown arrow,
point the mouse to the fourth
row on the palette, and click
the COGO Traverse button.

8. Type a name for the
computation and press Tab.

9. Type a comment for the
COGO traverse computation
and press Tab.

10. Click Angle Right as the
Angle Format.��
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11. Click the Parameters tab.

12. Snap to and click the start
point on the map. If the point
is not visible on the map,
type its name and press Tab.

13. Repeat step 6 and select the
traverse endpoint.

14. Repeat step 6 to choose the
backsight point.

15. Press Enter to accept the
default backsight Direction
value.

16. Press Enter to ignore the
foresight point.

17. Enter the courses of the
traverse.

18. Right-click the edit sketch in
the map and click Finish
Sketch.

�
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Linking survey
points to feature
geometry
Frequently, survey points are
added to the survey dataset
after the features they represent
have already become a part of
the established map fabric. In
most circumstances, the
computed locations of survey
points will not exactly match the
locations of the existing feature
vertices.

You can make a link between a
survey point and a feature
vertex using the Link tool or
the Link command.

The Link tool lets you snap and
click on a feature vertex and
then snap to and click the
related survey point. This
creates a link between the
feature vertex and the survey
point. �

Using the Link tool

1. Click the Editor menu and
click Snapping.

2. Check Vertex for the feature
layer to which you want to
create links.

3. Check Survey Points in the
Snapping Environment
dialog box.

4. Click the Link tool in the
Survey Editor toolbar.

5. Snap to and click the vertex
of the feature you want to
link.

6. Snap to and click the survey
point you want to link the
vertex with.

7. Verify that the link line is
displayed and that the link
symbol is displayed on the
feature vertex.

8. Repeat steps 5–7 for each
link you want to create.

See Also

To learn how to work with the
symbols for links, see Chapter 5,
‘Visualizing survey data’.

Tip

Multiple feature links to a
single survey point
A single survey point may have
links to multiple feature vertices.
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Using the Link command
and solving link conflicts

1. Zoom and pan the map to the
scale and location of the
features that you want to link
to survey points.

2. Click the Edit tool in the
Editor toolbar.

3. Click and drag a box around
the features on the map to
create a feature selection.

4. Click the Survey Editor menu
in the Survey Editor toolbar
and click Link.

5. In the Link Options dialog
box, type a value for the
Linking Tolerance.

6. Check Always link coincident
feature vertices.

This ensures that vertices
sharing the same location
will automatically be linked. If
this box is not checked,
coincident vertices are
treated as conflicts.

7. Click OK. �

�

Selecting features
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After making the link between a
survey point and a feature
vertex, link-lines are displayed
on the map.

Each feature is aware of the
survey points to which it is
linked. The links are stored with
the survey-aware features in the
database.

The survey point location can
change as additional measure-
ments and computations are
added to the survey dataset.
Similarly, the position or shape
of the feature can be edited. In
either situation, the link-lines
are updated after changes to
survey points or features are
made.

See Also

To learn more about how links
between survey points and  feature
vertices are stored, see Chapter 3,
‘Survey Analyst concepts’.

8. Continue with steps 9–14 if
the Link Conflicts dialog box
appears.

Otherwise, this task is
complete; no conflicts
occurred, and all points
within your specified
tolerance are linked to
feature vertices.

9. Use the Link tool to create
the correct links.

10. Click Solved once you have
created the correct link.

11. Click the forward and back
buttons to navigate to the
next conflict that you want to
view or solve.

12. Click Close if you have
completed solving all
conflicts or if you want to
continue with a different
task.

13. Repeat steps 9–12 for each
conflict as required.

14. Return to the stored conflicts
by clicking the Survey Editor
menu in the Survey Editor
toolbar and clicking Show
Link Conflicts.

Tip

Always link coincident
vertices
When using the Link command,
you can ensure that feature vertices
that share the same location are
automatically linked and not
detected as a conflict by checking
the Always link coincident vertices
box.
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Flashing the location of
the Link Conflicts
window on the map

1. Right-click inside the Link
Conflicts window and click
Flash Location.

2. Note that the area on the
map covered by the current
view in the Link Conflicts
window flashes on the map.

Tip

Flashing the location of the
conflict vertex
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Displaying the scale of the
Link Conflicts window as a
factor of the link tolerance

1. Right-click the Link Conflicts
window and click Properties.

2. Click Scale Relative To
Tolerance Circle.

3. Type a value for the factor.

4. Click OK.

Changing the display
scale for the Link
Conflicts window

You can change the scale at
which the Link Conflicts
window displays conflict
locations. There are three
methods for doing this:

• Zoom percentage

• Absolute scale

• Scale relative to tolerance
circle

Zoom percentage lets you
define a magnification based on
the current map scale.

Absolute scale lets you define
the scale directly.

You can also specify a display
scale based on the tolerance
that you specified for the link
command. For instance, to have
the view cover a region that
extends to double the size of
the tolerance distance, enter a
factor of two.

Displaying the scale of the
Link Conflicts window using
an absolute scale

1. Right-click the Link Conflicts
window and click Properties.

2. Click Absolute Scale.

3. Click the Scale dropdown
arrow and click the scale you
want to use.

You can also type the scale
directly.

4. Click OK.
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Breaking links
between survey
points and
features
You must explicitly break links
using either the Unlink tool or
the Unlink command. The
Unlink tool works by letting
you click the survey point or
vertex that you want to unlink.

To unlink a single feature
vertex, use the Unlink tool to
snap to and click the vertex that
must be unlinked. To unlink all
the feature vertices linked to a
survey point, use the Unlink
tool and click the survey point.

You can remove all the links for
selected features using the
Unlink command.

Using the Unlink tool

1. Click the Editor menu and
click Snapping.

2. Check Vertex for the feature
layer for which you want to
remove links.

3. Check Survey Points in the
Snapping Environment
dialog box.

4. Click the Unlink tool in the
Survey Editor toolbar.

5. Snap to and click the vertex
of the feature you want to
unlink.

6. If there are multiple links to a
survey point that need to be
removed, snap to and click
the survey point.

7. Verify that the link lines and
link symbols are no longer
displayed.

8. Repeat steps 5–7 for each
link that you want to break.

�




Unlinking survey points from feature vertices
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Using the Unlink
Command

1. Zoom and pan the map to the
scale and location of the
features that you want to
unlink.

2. Click the Edit tool in the
Editor toolbar.

3. Click and drag a box around
the features on the map to
create a feature selection.

4. Click the Survey Editor menu
in the Survey Editor toolbar
and click Unlink.

�

�

Features selected for unlinking
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Updating features
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Using the Update Feature
Vertices command

1. Zoom and pan the map to the
scale and location of the
features that you want to
update.

2. Click the Edit tool in the
Editor toolbar.

3. Click and drag a box around
the features on the map to
create a selection of the
features that you want to
update.

4. Click the Survey Editor menu
in the Survey Editor toolbar
and click Update Feature
Vertices. �

�
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Features selected for updating
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vertices may not coincide
with their associated survey
points.

• A combination of both the
above methods. The
transformation is applied
first, then the linked vertices
are shifted to exactly match
the location of survey
points.

Different types of
transformations are available.
These types include Simple,
Affine, and Helmert
transformations. The type that
can be used depends on the
number of links:

• For one link, a translation is
applied to all selected
features (Simple
transformation).

• With two links, a rotation,
translation, and scale are
applied to all selected
features (Simple
transformation).

• For more than two links, you
can choose either a Helmert
or an Affine transformation.

5. Check Set feature vertex to
the location of the survey
point if you want the linked
feature vertices to exactly
match their survey point
locations.

6. Check Apply transformation
algorithm if you want to
transform the unlinked
feature vertices based on the
existing links.

7. Click the transformation
dropdown arrow and click
the transformation method
you want to apply.

8. Click OK.

9. Confirm that the update
occurred as expected by
verifying the features’ new
locations and their link
symbology.

�
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Updated features—link symbols reflect the
changes made to the feature geometry.
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Analyzing and editing survey data 9
• The Survey Analyst toolbar

• Computation network concept

• Analyzing and computing the
active network

• Survey points and coordinates
concept

• Survey point and coordinate
analysis

• Scenarios for point and coordinate
analysis

• Editing survey objects

A computation network defines a sequence of dependent processes that
calculate a series of coordinates. The survey dataset manages one
computation network for each survey project. Since there are often many
survey projects in a survey dataset, there can be many computation
networks.

The process of analyzing computation networks involves detecting breaks in
the sequence of processes and identifying cycles in the sequences. This
chapter describes how Survey Analyst can be used to validate a
computation network by detecting and repairing these sequence breaks and
cycles. In Chapter 3, it expands on the description of computation states and
describes datum points.

Equally important to the validation of survey data is the process of Point and
Coordinate analysis. This type of analysis is used to authenticate the
relationships between survey points, coordinates, and the physical locations
they represent. Survey point and coordinate analysis requires searching for,
and correcting, inconsistencies in these relationships.

The Survey Analyst toolbar has commands that allow you to find instances
of these discrepancies in the computation networks and survey points. The
functionality available for editing survey data through the Survey Explorer
facilitates the repair of these problems.

This chapter describes how to use the Survey Analyst toolbar to work within
this environment.

Ch09.pmd 11/24/2003, 4:46 PM239
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The Survey Analyst toolbar

The Network dropdown
list lets you choose the

network you want to
analyze.

The Datum Points
button returns a
list of the datum

points for the
active network.

Survey Analyst
commands

The Point Merge tool
merges two points

displayed on the map.

The Compute
Survey Network

button computes the
active network.

The Computation Log opens
the Computation Network
Analysis window.
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Computation network concept
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Computation states
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C1
C2

C3

Computation Network

Input

Output
Network dependency

P3

P4
P2

P5

C1
C2

C3

Computation Network

Input

Output
Network dependency

P1

Datum point

Computation

Computed point

Points P1 and P2 do not depend on computations to define their
current coordinates. These survey points are, therefore, the datum
points in this computation network.
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C2C7

C2C5

C2C6

Starting from a computation
network in which all
computations are valid.

C2C4C2C3

C2C2

C2C1
depends on

C2C7

C2C5

C2C6C2C4C2C3

C2C2

C2C1
depends on

Edits to C4 make C5, C6, and C7 out-of-date.

Recomputing C4 results in it becoming either 
out-of-date, incorrect, incomplete, or valid.

C5, C6, and C7 remain out-of-date.

Survey Analyst detects that C4, C5, C6, and C7 need to 
be computed in sequence.

If C4 is determined to be incomplete       , or incorrect      , 
a break in the sequence is detected. Computations C4 to 
C7 cannot be processed, and remain out-of-date.

Scenario depicting the effect of computation edits in a network
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Network cycles
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Analyzing and
computing the
active network
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Computing and analyzing
the active network to
remove cycles

1. Start ArcMap, add the Editor
toolbar, and add the Survey
Analyst toolbar.

2. Add the survey projects and
feature layers that you want
to edit to the map.

3. Click the Editor menu in the
Editor toolbar and click Start
Editing.

4. Click the Network dropdown
arrow and click the name of
the network that you want to
compute.

5. Click the Compute Survey
Network button.

The Computation Network
Analysis window appears
and lists the sequence of out-
of-date computations
processed.

6. Click the Cycles tab in the
Computation Network
Analysis window.

7. Click the Cycles dropdown
arrow and click the cycle you
want to analyze.

8. Right-click the row in the
cycle list for which you want
to see details and click Show
Details. �

Computation Network Analysis window
showing list of processed and valid
computations. This network is valid.

� �

�

��
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The set of detail pages for
the points and computations
that appear in the row are
added to the Survey
Explorer.

9. Click the back and forward
buttons to view the detail
pages for the points and
computations that participate
in the cycle.

10. Identify the problem that is
causing the cycle and make
the required edits to correct
it.

In this example, the direction
distance computation is
changed to make a new
result point, called D.

11. Click the Compute Survey
Network button again.

12. In the Computation Network
Analysis window, click the
cycles dropdown arrow to
verify that there is one less
cycle.

13. Repeat steps 7–12 until you
have solved all the cycles.

14. Click the Close button on the
Computation Network
Analysis window.

�
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Opening the
Computation Network
Analysis window

1. Click the Computation log
button on the Survey Analyst
toolbar.

The results listed from the
previous network analysis
are displayed.

Listing the datum points
of a computation network
in the Survey Explorer

1. Click the Network dropdown
arrow and click the name of
the network for which you
want to list datum points.

2. Click the Datum Points button
on the Survey Analyst
toolbar.

The datum points appear in a
list page in the Survey
Explorer.

�

� �

The Survey Explorer displays a list page of datum points as a result of
running the Datum Points command.
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Computing and analyzing
the active network to
detect breaks in
computation sequences

1. Click the Editor menu in the
Editor toolbar and click Start
Editing.

2. Click the Network dropdown
arrow and click the name of
the network that you want to
analyze.

3. Click the Compute Survey
Network button.

The Computation Network
Analysis window appears.
The computations listed
include those that are
incorrect or incomplete.

4. Make note of the additional
information provided for
these computations.

5. Right-click the computation
in the list for which you want
to make corrections, or that
you need to complete.

A navigation context menu
appears.

6. Click Show Details.

7. Refer to the information you
noted in step 4 and correct or
add the required data to the
computation.

� �
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Survey points and coordinates concept
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Project 1 and Project 2 contribute to defining P1’s GIS
coordinate. Each project’s current coordinate is weighted
according to available quality information and averaged to
compute the final GIS coordinate.

The Coordinate Manager tab in the details page of a
survey point lets you specify the projects that should be
used for the GIS coordinate. For each project, you also
specify coordinates that are included in the mean and
the current coordinate.
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Survey point and coordinate analysis
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Based on the specified
tolerance, the points named
P2, P3, and P4 represent the
same physical location and can
be merged.

P2
P3

P1

P4

tolerance
GIS Coordinate

Merging survey points
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P5 has a coordinate that falls beyond a specified
tolerance from the mean. This coordinate may need to
either be recomputed, excluded from the mean, or
deleted.
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Survey points A and B are merged. A is the source point and B is the
target point. All coordinates from A are transferred to B and A is deleted.
For each project, a new mean coordinate is computed and is set as the
current coordinate. Only coordinates that originally contributed to the
current coordinate are used in the new mean.
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Survey Point Merge tool
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1. Start ArcMap, add the Editor
toolbar, and add the Survey
Analyst toolbar.

2. Add the survey projects and
feature layers that you want
to edit to the map.

3. Click the Editor menu in the
Editor toolbar and click Start
Editing.

4. Click the Point Merge tool.

5. Snap to and click the Source
survey point.

6. Snap to and click the Target
survey point.

After merging, the source point is deleted
and the GIS coordinate of the target point
is updated.

�
�

Merging survey points

�
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Point In Tolerance
command
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1. Click the Survey Analyst
menu in the Survey Analyst
toolbar and click Point In
Tolerance.

2. Type a horizontal search
tolerance value.

3. Check Vertical tolerance limit
for search and type a vertical
search tolerance value, if you
also want to define a height
range tolerance.

4. Click the Find points
dropdown arrow and click
your choice for specifying the
set of survey points that must
be tested.

5. Click OK.

The Point in Tolerance
window is displayed.

6. Use the Survey Point Merge
tool to merge pairs of survey
points, where required.

7. Click the back and forward
arrows to show the different
conflicts collected in the
window.

8. Click the Solved button to
remove conflicts from the set
shown in the window.

9. Repeat steps 6–8 for all
conflicts with which you want
to work.

10. Click the Close button.

See Also
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See Also
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Coordinate out of
Tolerance command
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Using the current coordinate
of survey points to find
coordinates that are out of
horizontal tolerance

1. Click the Survey Analyst
menu in the Survey Analyst
toolbar and click Coordinate
out of Tolerance.

2. Check Horizontal Distance
Limit for the search tolerance.

3. Type a value for the
Horizontal Distance Limit.

4. Click Local Check.

5. Click the Find points
dropdown arrow and click
points from active network
survey.

6. Click OK.

If survey points are found that
fall outside the limits you
specify, the Coordinate out of
Tolerance dialog box
appears.

Otherwise, a message is
displayed indicating that no
coordinates are out of
tolerance for the criteria you
specified.

7. Click the back and forward
buttons to view the details of
all the points with coordinate
displacements that fall
outside your tolerance limits.

8. Click Close.
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The Local Check method
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Navigating from the
Coordinate out of Tolerance
dialog box to delete an
incorrect coordinate

1. Run the Coordinate out of
Tolerance command.

2. Click in the table of the
coordinate conflicts to select
any one of them from the
table.

3. Right-click in the table of
coordinate conflicts and click
Go To Point.

The Detail page for the
survey point appears in the
Survey Explorer.

4. Click the leftmost column of
the incorrect coordinate to
select it.

5. Right-click the leftmost
column and click Delete.

In this example, the second
imported coordinate is
incorrect and is deleted.

Note that only imported
coordinates can be deleted. �

Based on the specified tolerance, P5
is detected as having a coordinate out
of tolerance using a local check.
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6. Click Refresh in the
Coordinate out of Tolerance
dialog box.

Note that the incorrect
coordinate no longer
appears and that the Delta
Easting and Delta Northing
values are updated.

7. Review the details page of
the survey point to make
other changes, if necessary.

8. Click Solved.

9. View other conflicts by
clicking the forward and back
arrows.

10. Repeat steps 2–8 to delete
other coordinates from
points that are out of toler-
ance.

11. Click Close.
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Navigating from the
Coordinate Out of Tolerance
dialog box to edit an
incorrect  measurement

1. Run the Coordinate out of
Tolerance command.

2. In the Coordinate out of
Tolerance dialog box, click
the row for the coordinate of
the computation to which you
want to navigate.

3. Right-click in the selected
row and click GoTo
Computation.

The detail page for the
computation that defines the
coordinate appears in the
Survey Explorer.

4. Make the necessary edits to
the measurement values in
the computation.

In this example, the distance
value in a Direction–
Distance computation is
corrected.

5. Click the Compute button.

6. Click Refresh and verify that
the delta values are within
the limits you specified for
the Coordinate out of
Tolerance command.

7. Click Solved to continue with
further analysis of the
remaining survey points, if
necessary.

8. Click Close.
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The Global Check
method
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Using the GIS coordinate of
points selected in the
Survey Explorer to find
coordinates that are out of
tolerance

1. Click the Survey Analyst
menu in the Survey Analyst
toolbar and click Coordinate
Out of Tolerance.

2. Check Horizontal Distance
Limit for the search tolerance.

3. Type a value for the
Horizontal Distance Limit.

4. Check Vertical Distance Limit
for the search tolerance if you
want to use a vertical limit.
Type a value for the Vertical
Distance Limit.

5. Click Global Check.

6. Click the Find points
dropdown arrow and click
points selected in the Survey
Explorer.

7. Click OK. �

�

Using a global check, P3 is detected
as having a coordinate out of
tolerance.
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Different fields are displayed in
the list, and these fields depend
on your choice of horizontal
and vertical options.

The columns displayed are:
UseforGIS, Delta Easting, Delta
Northing, Delta Height, Survey,
Easting, Northing, Elevation.

If a vertical check is not
defined, then Elevation and
Delta Height are not shown.
Similarly, if no horizontal check
is defined, then Easting,
Northing, Delta Easting and
Delta Northing are not shown.

Pressing the Solved button
removes the displayed conflict.
The Coordinate out of
Tolerance dialog box is not
automatically updated when
values are changed in the
Survey Explorer.

You can update the dialog box
view by clicking the Refresh
button.

Conflicts in coordinates derived
by computation can be solved
in the details view of the
relevant computation. Conflicts
in imported coordinates are
fixed by editing the relevant
coordinates in the survey
point’s detail page.

You can navigate to the
computations or points from the
Coordinate out of Tolerance
dialog box. The resulting detail
pages are displayed in the
Survey Explorer.

If survey points are found that
fall outside the limits you
specify, the Coordinate out of
Tolerance dialog box
appears.

Otherwise, a message is
displayed indicating that no
coordinates are out of
tolerance for the criteria you
specified.

8. Click the back and forward
buttons to view the details of
all the points with coordinate
displacements that fall
outside your tolerance limits.

9. Click Close.

Choosing the projects that
define the GIS coordinate
for a survey point

1. Add a detail page to the
Survey Explorer for the
survey point for which you
want to choose projects.

2. Click the Coordinate
Manager tab.

3. Click a project to view its list
of coordinates for the point.

4. Double-click the row of the
project that you want to have
participate in defining the
GIS coordinate.

5. Click Yes.

6. Press Enter.
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Updating Survey Points
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Using Update Survey Points

1. Click the Survey Analyst
menu in the Survey Analyst
toolbar and click Update
Survey Points.

The Update Survey Points
dialog box is displayed,
defining which points must
be shown in the Point out of
Date dialog box.

2. Uncheck Also list survey
points that cannot be up-
dated in this edit session due
to project locks.

This lets you exclude from
the list those survey points
that cannot be updated due
to project locks.

3. Click the Find points
dropdown arrow and click the
option that you want to use
for finding out-of-date survey
points.

4. Click OK.

5. Click the back and forward
buttons to view the survey
points that are out-of-date.

6. Click Update All, and skip to
step 9 if you do not need to
analyze and update points
individually.

7. Click Update to update the
GIS coordinate for the
displayed survey point.

8. Repeat steps 5–7 for all
survey points that need to be
updated.

9. Click Close.
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Viewing survey point details
from the Point out of Date
dialog box

1. Display the set of out-of-date
survey points by using the
Update Survey Points
command.

2. Click the back and forward
buttons in the Point out of
Date dialog box to find the
survey point for which you
want to see the details.

3. Click Details.

The Survey Explorer displays
the detail page for the out-of-
date survey point.

4. Repeat steps 2 and 3 to add
additional survey point detail
pages to the Survey Explorer.

5. Click the Previous page and
Next page buttons in the
Survey Explorer toolbar to
view the different detail
pages.

6. Click Close on the Point out
of Date dialog box.
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Scenarios for point and coordinate analysis

Scenario 1
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Scenario 2

*����	
��
���������
���
7���
#���������������
���������7���

�������1�����
������������������
� ������
�������
���������������=
*������
���
��������������#������������	
��
���������������	
�
����������
=�C�
��7��������
���
�
	�������.��
��������	����
*���
���������������
�����������
#�	�����������������#=

*��
�����
7������1�������#���
��������
������������(��	������
���
�����������	
��
��������7����������
7�����9�����8��*���
����
������������(��	���=



ANALYZING SURVEY DATA 263

Editing survey
objects
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Renaming survey points
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Changing a point’s name

1. Select the point in the list
page of the Survey Explorer.

2. Right-click the leftmost
column in the list and click
Go To Details.

3. Click the General tab in the
details page of the survey
point.

4. Click in the Point Name field
to the right of the prefix pin
and change the existing text
to the new point name.

5. Press Enter.

If the Invalid Point Name
message appears, you typed
a name that is already in use
by another point in the
project. In this case, go to
step 6.

Otherwise, you have
completed the task.

6. Click OK in the Invalid Point
Name message.

7. Repeat steps 4 and 5.
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Renaming computations
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Editing coordinates
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Changing a computation’s
name

1. Select the computation in the
list page of the Survey
Explorer.

2. Right-click the leftmost
column in the list and click
Go To Details.

3. Click the General tab in the
details page of the
computation.

4. Click in the Computation
Name field and change the
existing text to the new name.

5. Press the Enter key.

If the Information message
appears, you typed a name
that is already used in the
dataset. In this case, go to
step 6.

Otherwise, the task is
complete.

6. Click No in the Information
message box.

Note: clicking Yes will add a
detail page for the existing
computation to the Survey
Explorer.

7. Repeat steps 4 and 5.
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Editing measurement
values
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Changing imported and
computed coordinate values

1. Select the survey point in the
list page of the Survey
Explorer for which you want
to change coordinates.

2. Right-click the leftmost
column in the list and click
Go To Details.

3. Click the Coordinate
Manager tab in the details
page of the point.

4. Double-click the Easting
column of the imported
coordinate you want to edit
and type a new Easting
value.

5.  Press Tab and type a new
Northing value.

6. Optionally, press Tab and
type a new elevation value.

7. Press Enter.

8. Click the leftmost column to
select the computed coordi-
nate that you want to change.

9. Right-click the coordinate,
then click GoTo
Computation. �
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Editing a computation
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Changing survey project
properties
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The detail page of the
computation that defines this
coordinate is added to the
Survey Explorer. In this
example, a COGO Direction–
Distance computation has an
incorrect distance value.

10. Make the necessary
changes to correct the
mistake in the measurement
value.

11. Click the Compute button.

12. Click the Previous Page
button in the Survey Explorer
toolbar.

This returns the Survey
Explorer to the detail page
for the survey point.

13. Verify that the coordinate has
changed.

14. To make the updated
coordinate current, double-
click the Current column for
the computed coordinate
and click Yes in the
dropdown list.

15. Press Enter.
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Deleting survey objects
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Deleting coordinates
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Deleting imported
coordinates

1. Select the survey point in the
list page of the Survey
Explorer for which you want
to delete the coordinates.

2. Right-click the leftmost
column in the list and click
Go to Details.

3. Click the Coordinate
Manager tab in the details
page of the point.

4. Click the leftmost column to
select the imported coordi-
nate that you want to delete.

5. Right-click the coordinate
and click Delete.

�
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Deleting survey points
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Deleting measurements
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Deleting computation
measurements and survey
points

1. Click the Survey Objects List
from Map tool in the Survey
Editor toolbar.

2. Click and drag a box around
the measurements and
survey points that you want to
delete.

A new list page is added to
the Survey Explorer
containing the points and
measurements.

3. Click the leftmost column of
the first row to select it.

4. Hold down the Shift key while
clicking the leftmost column
of the last row in the list. All
measurements and points
are selected.

5. Right-click the leftmost
column and click Go To
Computations. �
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Deleting computations
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Deleting survey projects
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6. Check Input and Output in
the Navigate to Computa-
tions dialog box, then click
OK.

This adds a new list to the
Survey Explorer that has all
the computations that use the
selected measurements and
the selected points.

7. Use the method described in
steps 3 and 4 to select all the
computations.

8. Click the Delete survey
objects button in the Survey
Explorer toolbar.

9. Click the Previous Page
button to return to the list of
measurements and survey
points.

10. Select all the measurements;
click the first one listed, then,
while holding down the Shift
key, click the last one listed.

11. Click the Delete survey
objects button. �
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12. Select all the survey points
using the method described
in step 10.

13. Click the Delete survey
objects button.

Tip

Deleting survey points
%�����������	����
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��������������	���)����
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Deleting survey points selected in the Survey Explorer list page
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Managing shared survey data 10
• Survey datasets and versions

• Connecting to an ArcSDE
geodatabase

• Registering a survey dataset for
edit sessions

• Granting and revoking privileges

• Locking survey projects for edit
sessions

• Changing versions

In the enterprise geodatabase, ArcGIS offers an environment in which
multiple users can simultaneously edit the same set of GIS features by
creating named versions of the geodatabase. Conflicts between different
versions of the same GIS features are easily detected, reconciled, and
posted. For more information about versioning feature data, see Building a
Geodatabase and Editing in ArcMap.

When sharing survey data in your organization, the owner of each survey
dataset can grant many database users storing and editing privileges for the
data in the survey dataset. Once they have these privileges, each user
creates and uses their own survey projects, as described in Chapter 4,
‘Organizing survey data’.

Projects also enforce protection from edits by other survey dataset users.
Consider, for example, a project that contains the control points published by
your organization. The control points in the project can be used by any other
project in the survey dataset, but they can only be edited by the person
responsible for maintaining control points.

In order to edit survey data in a multiuser survey dataset, you need to acquire
a project lock. As the creator of a project, you are automatically given this
lock, and other users in your organization may access this information but
may not alter it.

The other function of the project locking system is to prevent conflicts in
survey dataset tables. A project lock ensures that simultaneous edits of a
single survey project are not possible.

This chapter presents the multiuser environment for survey datasets.

Ch10.pmd 11/24/2003, 4:47 PM271
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An error message appears if you start editing a nondefault
version of a geodatabase when its survey data is added to
the map.
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The conditions differ somewhat for survey points:

• Although a project cannot modify the properties of a point
that it does not own, subsets of coordinates can be added to
a survey point by different projects. These coordinates may
be owned by various survey projects, but only one of them
can own the survey point that contains the coordinates.
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Connecting to an
ArcSDE
geodatabase
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Creating a new ArcSDE
geodatabase connection

1. Click the plus sign next to
Database Connections in the
Catalog tree.

2. Double-click Add Spatial
Database Connection.

3. Type either the name or the
IP Address of the server to
which you want to connect.

4. Type either the name or the
TCP/IP port number of the
SDE instance to which you
want to connect.

5. If you are connecting to an
SDE server that supports
more than one database,
type the name of the
database to which you want
to connect. Otherwise, skip to
step 6.

6. Type the username and
password with which you will
connect to the SDE
geodatabase.

7. Check the check box if you
want to save the username
and password. This will let
you connect to the database
without being prompted to
log in.

8. Click OK.

9. Type a new name for the SDE
database connection.

10. Press Enter.

Tip

Testing the connection
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Connecting to a
geodatabase

1. Right-click the Database
Connection to which you
want to connect.

2. Click Connect.

The Catalog tree updates to
display the datasets in the
database.

Once it is connected to the database,
the Catalog tree updates to display
the datasets.

�
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1. Right-click the survey dataset
that you want to register for
edit sessions.

2. Click Register For Edit
Sessions.

Registering a
survey dataset
for edit sessions
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Tip

Registering data for edit
sessions
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1. Right-click the survey dataset
for which you want to change
privileges.

2. Click Privileges.

3. Type the name of the user for
whom you want to change
privileges.

4. If you want to revoke all the
user’s privileges, leave
SELECT unchecked and skip
to step 7. Otherwise, proceed
to step 5.

5. Check the SELECT check
box to grant the user select
privileges.

6. If you want to grant full
privileges to the user, then
check one of the UPDATE,
INSERT, or DELETE check
boxes (checking one will
make them all checked).
Otherwise, proceed to step 7.

7. Click Apply to change the
user’s privileges.

8. Repeat steps 3–7 to change
the privileges of other users.

9. Click OK.

Granting and
revoking
privileges
To allow other database users
to create, edit, and acquire
locks on survey projects, the
owner of a survey dataset must
grant those users full dataset
privileges. Full privileges
include SELECT, UPDATE,
INSERT, and DELETE privileges
for the survey dataset tables.

To allow read-only access to
the survey projects in the
survey dataset, the owner must
specify SELECT privileges only.

Once granted, privileges may
also be revoked by the owner of
the survey dataset. The same
command dialog box that is
used to grant privileges is also
used to revoke privileges.

Granting or revoking privileges
on a survey dataset applies the
same privilege changes to all
the survey dataset tables. If
you add a package to the
survey dataset to support new
measurement or computation
types, you need to grant
privileges on the survey dataset
again.
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Viewing lock information
for a survey project

1. Right-click the survey project
for which you want to view
lock information.

2. Click Properties.

3. Click the Locking tab.

The Locking tab displays
information about whether
the project is locked or not,
about which database user
has the lock, and the date
and time that the lock was
acquired. Additional
information about the lock
may be available in the
Comment field.

4. Click OK.

Locking survey
projects for edit
sessions
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Unlocking a survey
project

1. Right-click the survey project
that you want to unlock.

2. Click Properties.

3. Click the Locking tab.

4. Click Lock Survey Project to
uncheck the check box. The
lock information is removed
from the Survey Project
properties.

5. Click OK.

The project is now unlocked
and available for locking by
other database users.

Locking a survey project

1. Right-click the survey project
that you want to lock.

2. Click Properties.

3. Click the Locking tab.

4. Check the Lock Survey
Project check box. Your user
name is added to the Locked
By text box, and the date and
time are added to the Date
text box.

5. Optionally, type a comment
into the comment field.

6. Click OK.

The survey project is now
locked for your edits.
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Identifying the user that
has locked a project—
alternative method

1. Right-click the survey project
for which you want to identify
the user that has the lock.

2. Click Survey Project Locking.

If the project is currently
locked by another user, the
Project Locking message box
indicates the user that has
the lock.

3. Click OK.

Otherwise, the Project
Locking dialog box provides
other choices as described in
the next task—‘Viewing or
changing the lock status of a
survey project—alternative
method’.
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Viewing or changing the
lock status of a survey
project—alternative
method

1. Right-click the survey project
for which you want to view or
change the lock status.

2. Click Survey Project Locking.

The Project Locking
message box indicates
whether the project is locked
or unlocked.

3. Click No if you want to
maintain the current lock
status for the project;
otherwise, skip to step 4.

4. Click Yes to switch the lock
status from locked to
unlocked or vice versa.

Tip

Acquiring a lock while
working in ArcMap
If ArcMap is already running, a
lock can be obtained from within
ArcCatalog without restarting
ArcMap. You will need to stop
editing, acquire the lock in
ArcCatalog, then start editing in
ArcMap.
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Changing to the default
version of the
geodatabase

1. If you are editing the data,
click the Editor menu and
click Stop Editing. Save your
edits if neccessary.

2. Click the Source tab at the
bottom of the table of
contents to list the
workspaces in your map.

3. Right-click the workspace
that you want to change to
the default version.

4. Click Change Version.

5. Click the default version in
the Change Version dialog
box.

6. Click OK.See Also
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Bearing method
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critical value
The specific cutoff point that determines acceptance or rejection
of a hypothesis. Critical values are determined by the choice of a
level of significance (α).

current coordinate
The single coordinate for a survey point that is the best
representation for that survey point’s location within each
project. A current coordinate is required when the same project
computes or imports more than one coordinate for a particular
survey point.

datasnooping
The process of testing each measurement using the W-test.

datum points
When used in the context of a computation network, this refers to
survey points that are not defined by computations, but that are
the input data for the initial computations in the sequence of
computations.

Detail page
One of two types of pages in the Survey Explorer. The Detail page
displays a detail view of individual survey objects.

direction field
Field in the computation page that lets you enter bearings or
azimuths between an input survey point and a computed survey
point.

display unit
Although they are stored with consistent units in the survey
dataset, you can choose the units in which coordinates and
measurements are displayed in the Survey Explorer. These are the
display units.

distance field
Field in Survey Explorer that lets you enter the distance for use in
a computation.

edit sketch
A temporary sketch that is used to perform a variety of tasks.
Creating an edit sketch is a standard way to edit feature geometry.

ellipsoid
The mathematical approximation of the earth’s surface.

error propagation
A method of transferring statistical information about the spatial
quality of survey points to other survey points.

Extensible Markup Language (XML)
A markup language similar to HTML. With XML you define data
using tags that add meaning. For example, <title>California
geology</title> declares the text “California geology” to be a title,
perhaps for a map. An XML file does not contain information
about how to present the data. XML is well formed if an opening,
tag, such as <title>, and a closing tag, such as </title>, appear
before and after each piece of data.

feature codes
Blocks of text included in data collector file formats that are used
to describe the features surveyed in the field.

fixed reference points
Survey points used as an input to a computation. Its coordinates
are not updated by the computation.

focus field
The particular field that is the current target for data entry.
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measurement error
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TPS setup
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